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Freie Geodaten aus dem Netz ;.‘ i e
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Quellen fur freie Geodaten

OpenStreetmap
http://www.openstreetmap.org/
OpenStreetmap-Online-Karte: Datenexport Uber reiter-Export
http://download.geofabrik.de/osm/europe/germany/

Aktuelle OSM-Daten im nativen OSM-Format (*.osm.bz2 entpackt zu *.osm)
sowie als Shapefile mit reduzierten Objektklassen.
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XY Corine Landcover

http://www.corine.dfd.dIr.de/intro_de.html
Landnutzungsdaten des europaischen CORINE-Projektes

Administrative Grenzen als Shapefile -weltweit und andere Geodaten
http://www.gadm.org/

http://www.diva-gis.org/Data
Diverse frei verflugbare Geodaten

SRTM-X-Band Daten (Hohendaten, besser auflosend als SRTM)
http://eoweb.dlr.de:8080/index.html

SRTM: Weltweite Hohendaten
http://netgis.geo.uw.edu.pl/srtm/Europe/ oder
http://dds.cr.usgs.gov/srtm/version2_1/SRTM3/Eurasia/
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Online Dienste WMS und WFS ;,‘
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5 WMS-Server (Web-Map-Service)
< (Rasterbasierender Internet-Kartenservice)
“ Zugriff uber QGIS: Layer > WMS-Server hinzufugen
T WMS-Server lassen sich hinzufugen und die Layer laden. Auswahl des KBS ist moglich.
il Schaltflache neu: Server zur Liste hinzufiigen
Anzeigen der WMS-Legende erfordert Installation der Erweiterung CSI WMS Legend:
Erweiterungen > Python-Erweiterungen herunterladen > Reiter: Repositorien
URL: http://osgis.csi.it/qgis _plugin/csi_plugin test.htm hinzufugen
Xy Reiter Erweiterungen: CSI WMS Legend installieren
> Deutschland (URL Uber Layer > WMS-Server hinzufugen : Neu in qgis eintragen)
~ http://wms1.ccgis.de/cgi-bin/mapserv?map=/data/umn/germany/germany.map&&VERSION=1.1.1&REQUEST=GetCapabilities&SERVICE=WMS
® http://ims1.bkg.bund.de/bund/servlet/gtEntryPoint?
) Hessen (URL uber Layer > WMS-Server hinzufligen : Neu in qgis eintragen)
D http://www.gds-srv.hessen.de/cgi-bin/lika-services/ogc-free-maps.ows?
Ubersicht iiber diverse Server
B (http://www.skylab-mobilesystems.com/ger/wms_serverlist.ntml)
N
) WFS-Server (Web-Feature-Service)
x (Vektorfeature werden Ubers Netz ins GIS geladen und kdnnen wie gewohnliche Vektorlayer abgefragt und
symbolisiert sowie als Shape etc. abgespeichert werden)
Zugriff Uber QGIS: Layer > WFS-Server hinzuflgen
Beispiel: Naturschutzgebiete Rheinland-Pfalz (URL liber Layer > WFS-Server hinzufligen : Neu in qgis eintragen)
http://map1.naturschutz.rlp.de/service lanis/mod_wfs/wfs_getmap.php?mapfile=naturschutzgebiet
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http://osgis.csi.it/qgis_plugin/csi_plugin_test.htm

Nutzung von Google-Luftbildern in QGIS
2 A4 RRELPPS vREBR s a2 RE& FRAIAICQLAR PO v
CORL*“ B ""dkPNi L@ e v "EN - Sa@s 1@ @D [dielddldl]
Layss = |
o Erweiterung OpenlLayers

- Mit der Erweiterung Openlayers lassen sich Google-Luftbilder direkt ins Programm laden.
A Die Bildausschnitte lassen sich als georeferenzierte Luftbildmosaike speichern.

{1 Quantum GIS 1.6 0-Capiapo
Datel Bearbeiten Ansicht Layer Einstellungen Erweiterungen CadTools Hilfe Click-fu Vekior Raster SelectPlus
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.r.: OpenStreetMap *J Add Google Physical layer
Photo2Shape *8 Add Google Streets layer
Points20ne *J Add Google Hybrid layer
QuickWKT

Raster Colours
@! Add Yahoo Street layer

! Add Yahoo Hybrid layer
! Add Yahoo Satellite layer

Rasterbasierte Geldndeanalyse. ..

RasterFilelnfo

3
»
3
: 2 Add Google Satellite layer
3
3
3

R&umliche Abfrage
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Nutzung von Google-Luftbildern in QGIS
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A Erweiterung OpenlLayers
R Mit der Erweiterung Openlayers lassen sich Google- und
= OpenStreetmap-Daten direkt in die Kartenansicht laden.
Die Bildausschnitte lassen sich mit Hilfe verschiedener Werkzeuge als
georeferenzierte Luftbildmosaike speichern.
Openlayers-Plugin installieren
- Erweiterungen > Python-Erweiterungen herunterladen
o Zum Reiter Erweiterungen wechseln:
P In die Filter-Zeile OpenLayers schreiben
(53 OpenlLayers-Plugin installieren
%)
N
»
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Nutzung von Google-Luftbildern in QGIS ; i3
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ﬂ Google-Satelitenbild uber die Erweiterung OpenLayers laden
- Laden Sie das Shapefile GEBIETSGRENZE
Laden Sie anschlieBend das Satelitenbild mit dem Menuaufruf
Erweiterungen > OpenLayersPlugin > Google Satelite Layer
XY
Wenn nichts angezeigt wird ZOOMEN Sie auf die Gebietsgrenze
e — Layer > auf Layerausdehnung zoomen
Lo} OpenStrectitap " |*3 Add Google Physical layer anschlieBend uber Ansicht > hineinzoomen
Photo2Shape " |5 Add Google Streets layer . . . .
) Points20ne * a3 Add Googe Hybrid ayer mit der Maus in den gewunschten Bereich zoomen
D - 5 0 Googi ot yer |
@ astef o.ours B " ! Add Yahoo Street layer
B EZ::IE?::EJB S : ! Add Yahoo Hybrid Iaier
jé"'\ Raumliche Abfrage , |©' Add Yahoo Sateliite layer
P Hinweis: OpenLayers stellt das Koordinatensystem um!
Das KBS auf ,Projiziert > Mercator > WGS84 PseudoMercator” gesetzt
Gleichzeitig wir die ,On the Fly KBS-Transformation® aktiviert!
Somit werden alle geladenen Layer bezogen auf die Google-Layer projiziert!
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Nutzung von Google-Luftbildern in QGIS e
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A Hochauflosendes Luftbild aus Google-Satelitenbild exportieren
- Mit
¥ Datei > Bild speichern als
L) |lasst sich die jeweilige Ansicht als georeferenziertes Bild speichern.
Um ein hochauflosendes Bild zu erreichen, zoomt man weit in die Ansicht hinein
und speichert jeweils kleine Auschnitte, die spater zusammengefugt werden!

oy Die Ausschnitte lassen sich einfacher wahlen,

U Vekloroitter 2] wenn man sich vorher ein Vektorraster anlegt
g — - — 'i Vektor > Forschungswerkzeuge > Vektoraster

N
% o (sxzezas 301 ) v [ s93m1d6. 75 ] Messen Sie vorher aus, wie groR die Gitterzellen sein missen,
e [zurescezss | e [soamass.seae ] um einen Ausschnitt in der von lhnen benétigten Auflésung zu erzeugen
~Parameter Je nach Bildschirm und gewunschter Auflosung kann z.B.
gr x [son.onoooonoon |2 N\ eine Ausdehnung von 900 x 600 m sinnvoll sein.
A s Abgrenzung des Netzes

) " Lonlooneoomn 15 aus Ansicht oder Layergrenze
:.: ®: Raster als Polygone ausgeben

/]

I Raster als Linien ausgeben
susgabeshapedatsi \

['Sonstiges,-"nutzerk0nf,-"datenl-"OnIine_Datenquellen_nutzenl."netzl.shp] [ Durchsuchen l

GroRe der Gitterzellen

(] 0% [ ok || oese |
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Nutzung von Google-Luftbildern in QGIS
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A Hochauflosendes Luftbild aus Google-Satelitenbild exportieren
4| Laden Sie das neue Vektorraster, stellen Sie nur die Grenze ohne Flachenfarbe dar und
R beschriften den Layer nach der ID (Nummerierung)
X (Siehe Folienscript QGIS-Basisfunktionen)
Anschlie3end konnen Sie die nummeriertem Zellen des Rasters als Orientierung nutzen und
» Mit
Datei > Bild speichern als
die Bildausschnitte als Tif-Datei speichern
® Vor dem speichern die anderen Layer und die
& Dekorationen (Ansicht > Dekorationen) ausblenden,
g sonst haben Sie das Vektorraster und die Maldstabsleiste auf Ihrem fertigen Luftbild!
%)
&
e Als nachstes mussen Sie die gespeicherten Kacheln zusammenfugen, um Sie dann in ein
’ beliebiges KBS (GK3, UTM etc.) umzuprojizieren!
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Nutzung von Google-Luftbildern in QGIS i
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Aus Google exportierte Luftbilder verschmelzen und umprojizieren |

Fassen Sie die Bilder mit der Funktion Raster > Sonstiges > Virtuelles Raster erzeugen (gdalbuildvrt)

in einem virtuellen Raster (Rasterkatalog) zusammen (hohe Auflosung auswahlen).
Wahlen Sie als Eingabedatei die eben gespeicherten Bilddateien (mit der Maus und gleichzeitig gedruckter STRG-Taste
anklicken oder Verzeichnis auswahlen) aus und nennen Sie die Ausgabedatei jever.vrt

AnschlieBend projizieren Sie die neue Tif-Datei nach GK 3 um

Menuaufruf: Raster > Projektionen > Transformieren

Eingabedatei: Das virtuelle Raster, welches aus den einzelnen

~Schnappschlissen erstellt wurde.
Ausgabedatei: jever GK3.tif
Eingabe-KBS:

Projiziertes Koordinatensys. > Mercator > WGS84 PseudoMercator

Ausgabe-KBS:

Projiziertes Koordinatensys. > Transverse Mercator >DHDN Gaul3-Kruger 3

Jetzt verfugen Sie Uber ein hochauflosendes

Luftbild im GK3-KBS,

In ein anderes Dateiformat konvertieren:
Menuaufruf: Raster > Konvertierung > (bersetzen (gdal-translate)

" Transformieren (Reprojizieren) HE

[] stapelverarbeitungsmodus (zur Bearbeitung eines ganzen Verzeichnisses)

Eingabedatei ’nf_.-'g00gIe_Iufthilder_.-'gesamt2.w‘t|Ll Wahlen...
Ausgabedatei ’F_.-'google_lufthiIder_.-'gesamt_GKBb.tif] Wihlen...

[¥) Eingabe-KBS [ePsG:ass? ] [m
[X] Ziel-KBS [EPsG:31467 ] [m
[®] stichprobenmethode [Nah |'l
[ kein-Datum-Werte [0 ]
[ maskenlayer |Po|\,‘gone_gesamt |j [m
[ Speicher fir Caching [20MB B
Grife dndern
F?reite (3000 = Hohe [3000 E

[%] Parallele Entzerrungsimplementation verwenden

[%] Nach Abschluss zur Karte hinzufiigen

gdalwarp -s_srs EPSG:3857 -t_srs EPSG:31467 -r near -multi -of GTiff

G:fnutzerkonf/google_lufthilder/gesamt2.urt =

G:fnutzerkonf/google_luftbilder/gesamt_GK3b.tif
[ oK l [ Close l [ Help l
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OpenStreetmap-Daten nutzen b k‘fr
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OpenStreetmap-Daten

OpenStreetMap ist ein Projekt mit dem Ziel,
frei verfugbare Geodaten zu sammeln oder zu erfassen und jedem Interessieren zur Verfligung zu stellen

Aus den Daten lassen sich thematische Karten rendern,

die Uber das Web oder andere Wege publiziert werden konnen.
OSM publiziert eine eigene Karte uber den Webbrowser

http://www.openstreetmap.de oder http://www.openstreetmap.org

Sowohl die gerenderten Karten als auch die Daten sind frei verfugbar, lizensiert unter der

Open Data Commons Open Database License (ODbL)

OpenStreetmap-Karten ins GIS laden

Verschiedene OSM-Karten lassen sich mit der Erweiterung OpenLayers wie die Google-Luftbilder ins QGIS
laden. Auch im ArcGis gibt es diese Moglichkeit

Menuaufruf

QGIS: Erweiterungen > OpenlayersPlugin > OpenStreetmapLayer etc. hinzuflgen
ArcGis: Daten > Daten hinzufugen > Grundkarten hinzufigen
Der Bildschirminhalt lasst sich wie bei Thema Google beschrieben, als georeferenziertes Bild speichern
Im QGIS sind uber OpenlLayers neben der Standard OSM-Karte folgende Themen verfugbar
OpenCycleMap
OCM PublicTransport
OCM Landscape

. . UNIKASSEL Architekt
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http://www.openstreetmap.de/
http://www.openstreetmap.org/
http://opendatacommons.org/licenses/odbl/
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OpenStreetmap-Daten nutzen
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Beispielkarte aus dem Webbrowser
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OpenStreetmap-Daten nutzen
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Beispielkarte aus dem Webbrowser
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H Suchan | Karte bearbeiten! Fehlar melden
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OpenStreetmap-Daten nutzen pl
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OpenStreetmap-Daten nutzen ;,‘ i

N = OSM mit OpenLayers visualisieren

Menuaufruf
Erweiterungen > OpenlayersPlugin > OpenStreetmap hinzufligen
Anschliel3end auf das gewlnschte Gebiet zoomen (z.B. mit Hilfe eines geladenen Shapes)

OpenStreetmap-Daten herunterladen

Die uber das Web verfugbaren Karten werden aus den, in einem offenen XML-Format
veroffentlichten Daten gerendert. Diese Daten sind frei verfugbar und lassen sich im GIS nutzen.

Insbesondere Strallen, Wege, Waldflachen und Gewasser sind gut erfasst.
In manchen Gebieten auch andere Flachennutzungen und Gebaude.
Stadtplane aus OSM-Daten sind meist sehr detailreich und prazise.

Die XML-Daten (*.OSM) lassen sich fur kleinere Gebiete direkt aus dem Netz
ins QGIS laden oder Uber einen Webbrowser herunterladen.

Vor dem Herunterladen der Daten zoomen Sie auf das gewilinschte Gebiet und setzen
unter: Einstellungen > Projekteinstellungen >Koordinatenbezugssystem
das Kreuzchen bei ,,On the Fly KBS-Transformation aktivieren*

AnschlieBend: Menuaufruf:
Web > OpenStreetmap> OSM-Daten herunterladen
Small Scale angeben, ,Daten nach dem laden automatisch 6ffnen“ ankreuzen

. . UNIKASSEL Architekt
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Download OSM-Daten
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8 Geogr. Lange:  Von | 78529754800 | Nach | 7.9133750486 |
Boem:h
'ﬁ et OK! GriBbe wird wahrscheinlich vom Server akzeptiert. E]
- N Herunterladen nach:

=

[ D:fLehre/GIS_1_Vorlesung/2011_neujosm/download. osm

; [3] Daten nach Laden automatisch 6ffnen

Q“'"”“‘la.(,-,, 1 _ :D [] Aktuelle Daten ersetzen (aktueller Layer wird entfernt)
: ey :
' [3]| Benutzerdef. Darstelung [Small scale | Y]
, - [Herunterladen] [ Abbruch ]
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OpenStreetmap-Daten nutzen b k‘fr

4 dd _RR"RELPPSI LRwWQ s gEeeas [l LEa PO
©L) > BN =g vx "B -Sa@eée @ .0 S@O (dieldldldld
Layer = |
@ OpenStreetmap-Daten direkt ins QGIS laden
Alternative: Download aus dem Webbrowser:http.//www.openstreetmap.org/
N Reiter: Export / Format: OpenStreetmap-XML-Dateien
"_f_t In beiden Fallen wird eine Datei Name.osm auf der Festplatte gespeichert, die Uber den Menuaufruf

Web > OpenStreetmap > OSM aus datei laden zu offnen ist.
jever.osm finden Sie als Beispieldatei

Ein Punkt-, ein Linien- (Strallen etc.) und ein Polygonlayer (Gebédude, Flachennutzung) werden angezeigt.

Die Daten werden thematisch visualisiert, fur eine Weiterverarbeitung ist die
Konvertierung in ein gis-gangiges Format (Shapefile, sqlite etc. notwendig)

Der OSM-Server erlaubt aktuell aus Kapazitatsgriinden
nur eine Ausdehnung des Downloads von 0,25° in Geog. Ldnge und Breite

Daten ganzer Lander lassen sich uber den Anbieter Geofabrik herunterladen
http://download.geofabrik.de/osm/europe/germany/

Die einzelnen Layer als Shapefile oder spatialite speichern

Menuaufruf
Layer > speichern als
KBS: DHDN GK3 / Format: ESRI-Shapefile oder Spatialite
FUr SpatiaLite spricht, dass die Attribute der Spalte tags auch bei grol3er Lange nicht gekurzt werden.
Layer in die Ansicht laden!
Nur im Format Spatialite ist gewahrleistet, dass die tags in voller Lange mitgenommen werden.

. . UNIKASSEL Architekt
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KBS: WGS 84 — muss umprojiziert werden
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Zum Datenformat

Die OSM-Daten werden in einem XML-Dateiformat ausgegeben,
dass heil3t die Daten stehen als Text in einer definierten XML-Syntax zur Verfigung.

Die Syntax beschreibt GeoObjekte (Nodes, Ways, Relationen) und ihre Eigenschaften (tags).
Nodes sind einzelne Punkte, deren Position in der Welt Uber geographische Koordinaten definiert werden.

Sie verfugen Uber eine eindeutige ID, Uber Koordinaten
(lat = Geog. Breite und lon = geog. Lénge jeweils in Dezimalgrad z.B. [at="53.5763732" lon="7.8881323" )
und konnen Uber Eigenschaften (tags) verfugen, wenn es sich um eigenstandige Inhalte,
wie z.B. eine Haltestelle handelt.

Ways fassen Nodes zu Linien- oder Polygon-Objekten (geschlossener Linienzug) zusammen.
Die Nodes werden uber ihre IDs den Ways zugeordnet.
Jeder Way enthalt seinerseits eine ID und kann Uber Sacheigenschaften (tags) verfugen.

Relationen beschreiben komplizierte Objekte, wie z.b. Multipolygone und Polygone mit Lochern bzw.
Polygone in Polygonen. Eine Relation besteht aus verschiedenen Ways, die innerhalb der Relation eine
bestimmte Rolle spielen. Soll z.B. ein Teich inmitten eines Waldes erfasst werden, so ist das Ufer des
Teichs zugleich der Rand des Waldes. Dieser geschlossene Linienzug (Way) beschreibt in der Relation
Teich das Ufer und in der Relation Wald die Innengrenze.

. . UNIKASSEL Architekt
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E] Eeryes CIESR 5
o Nodes
“ Dieser Node mit tags beschreibt eine Ampelanlage
w
Eindeutige ID Geograph. Breite
in Dez.Grad m
Geograph. Lange
m <node>
"\ <node id="30463017" 1at="53.5763732" lon="7.8881323" user="GPS-Wolf" uid="38735" visible="true"
> version="4" changeset="3328371" timestamp="2009-12-08T21:28:52Z2">
® <tag k="highway" v="traffic_signals"/> X
% node> Erfassungszeitpunkt
tag beginn .
B Schliissel (key) des tags Value (Wert) des keys
. = highway = Traffic_signals
N
)
»

Node ohne tags

<node id="30463010" |at="53.5763732" lon="7.8881323" user="GPS-Wolf" uid="38735" visible="true" version="4"
changeset="3328371" timestamp="2009-12-08T21:28:522"/>

. . UNIKASSEL Architekt
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Layer [

Ways

Dieser Way mit tags beschreibt ein Gebaude

Eindeutige ID
des Ways

Nutzer und
NutzerID

</way>

<way id="77867746" user="masju + Team" uid="292160" visible="true" version="1" changeset="5802123" timestamp="2010-09-17T09:45:572">

915352863"/>
"9156351027"/>
"915354903"/>
"9015354337"/>

Der erste und der letzte

IDs der beteiligten
sind indentisch,
also ein Polygon mit fiinf Eckpunkten

ANNANNANNA

"915352863"/>

<tag k="addr:country" v="DE"/>%—— |
<tag k="addr:city" v="Jever'><

<tag k=tbuilding" v="yes"/>a

e \

<tag k="addr:postcode" v="26441 "/><,,,,%:::::fffw—%
<tag k="addr:housenumber" v="6"/>e | = ]
<tag k="addr:street" v="Am Woltersberg"/> w¢

~«in Deutschland
< n Jever
T PLZ: 25442
_—Mit der Hausnummer 6
~«in der Strae ,Am Woltersberg“
T «Ein Gebiude

Verschiedene tags beschreiben die Eigenschaften des Polygons:

Schlussel (key) des tags

= building = yes

Value (Wert) des keys

Online-Datenquellen mit QGIS

Dr.-Ing. Claas Leiner

Architektur
Stadtplanung
Landschaftsplanung



OpenStreetmap-Datenformat il

444 _RRE PP R Q s gEeeas [l LEa PO
©WL:2BEsE""dhRNa XL =R e v *"FE - -Saa@de 8. @O [dleldldldld
Layer [ [
Eq Relationen
e §
< Diese Relationen beschreiben einen Wald mit zwei Wiesen im inneren
. Relation und
y Relation ID
XN
</relation>
< ="1178363" user="masju + Team" uid="292160" visible="true" version="1" changeset="5785982" timestamp="2010-09-15T11:03:54Z">
tmember type="way" ref="77616535"role="innef"/> Drei Ways sind Mitglieder der Relation.
xy kmember type="way" ref="77616536" role="inner"/> Einer stellt diese AuBengrenze (role = ,,outer”) und zwei die
. fmember type="way" ref="77616611" role="outer"/> Innengrenze der Locher (role = ,,inner®) dar
. [ftag k=:type" v=':'mLc{t/poly€on"/> /
@ [fiag k="landuse" v= forest"/> Die tags beschreiben die Relation als
e </relation> Multipolygon und als Waldgebiet
s </relation>
a E ="1178183" user="masju +/Team" uid="292160" visible="true" version="1" changeset="5784819" timestamp="2010-09-15T08:44:227">
B member type="way" ref="77616535" role="outer"/> |
gr member type="way" ref="77616536" role="outer"/> |
* ktag k="type™ v="multipolygon"7> Zwei Ways sind Mitglieder der Relation.
? <tag k="landuse" v="meadow"/> Einer stellt diese AuBengrenze des einen Lochs (role = ,,outer”) und einer die
IS </relation> AuBengrenze des anderen Lochs dar (role = ,,outer”) dar.
k Es sind die gleichen Ways, die die Innengrenzen des Waldpolygons beschreiben.

Die tags beschreiben die Relation als
Multipolygon und als Wiese

. . UNIKASSEL Architekt
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- - Attribute nach QGIS-Direktimport

Die als Shapefile oder SpatialLite gespeicherten Daten verfugen Uber eine Attributtabelle,
in welche die Inhalte der tags eingetragen werden. Beim QGIS-Direktimport (Web > Openstreetmap) gibt es
Einschrankungen bei komplexen Multpolygon-Relationen, so dass z.B. komplexe Flachennutzungen (Walder
mit enthaltenen Gewassern, die wiederum Inseln enthalten), nicht vollstandig importiert werden.
Als Alternative bietet sich der Import in eine PostGIS-Datenbank oder der Import Uber spatialite_osm_map .

Diese Vorgehensweise wird spéater beschrieben

g0 o0

Sie finden folgende Attributspalten vor.

Attributspalte tags

In der Attributspalte tags finden Sie die tags des jeweiligen Objektes in der ursprunglichen Syntax und

® vollstandigen Lange, wenn die Daten ins SpatialLite-Format gespeichert wurden .
% Im Shapefile-Format werden sehr lange Attribute abgeschnitten.

é Infos zu den Attributen (tags) in OSM:

5 http://wiki.openstreetmap.org/wiki/DE:Map_Features

N

” Weitere Attributspalten

Beim OSM-Import werden die tags ausgewertet und verschiedene thematische
Attributspalten angelegt, die eine einfache Kategorisierung ermaoglichen:
name, place, highway, landuse, waterway, railway, amenity, leisure, tourism, learning
Die Gebéaude lassen sich nur aus der tags-Spalte extrahieren.

. . UNIKASSEL Architekt
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E] Layer = |
fa Erlauterung der Attribute nach QGIS-Direktimport
.,3: tags: OSM-Attributierung in vollstandiger Syntax
name: Eigennamen von Objekten zur Beschriftung (z.B. Stallennamen)
place: Platze
highway: Kategorisierung von Straf’en und Wegen
landuse: Flachenhafte Landnutzung
XY waterway: Gewasser
. railway: Schienenverkehr
~ amenity: Offentliche Einrichtungen, private Dienstleistungen (Kindergarten, Tankstelle, Feuerwehr etc.)
X leisure: Freizeitnutzung, wie Sportplatze, Spielplatze, Parks etc.
D) tourism: Fremdenverkehr
) learning: Bildungseinrichtungen
® Die Gebéude lassen sich nur aus der tags-Spalte extrahieren, weil es keine Spalte fiir Gebdude gibt.
?:3 Beim den beiden anderen Importverfahren sieht es anders aus.
n
Infos zu den Attributen (tags) in OSM:
http:/Iwiki.openstreetmap.org/wiki/DE:Map_Features
Online-Datenquellen mit QGIS Dr.-Ing. Claas Leiner 3 I: IR KsA| STS-AI-EI{ &%\%ﬁ%ﬁngl
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& Alternativen zum Direktimport
Die Visualisierung der direkt importierten OSM-Daten erfordert haufig (z.B. bei der Visualisierung von
N Gebauden) die Auswertung der tags-Spalte mittels Ahnlichkeitsabfragen (tags like '%building%'). Zudem
N werden Multipolygon-Relationen nicht fehlerfrei Ubernommen. Alternativen sind der Import Gber das
= Kommandozeilenprogramm spatialite_osm_map welches die unterschiedlich tag-Kategorien in eigene Layer
innerhalb einer Spatialite-Datenbank separiert,
so dass es einen Gebédudelayer, einen Landuse-Layer etc. gibt.
oder

Xy der Import in eine PostGis-Datenbank, was sich insbesondere bei gro3eren Datensatzen wie z.B. OSM-

Daten eines ganzen Landes empfiehlt. Bei diesem Verfahren ist eine PostGIS-Datenbank aufzusetzen, in die

mittels osm2pgsql (aus QGIS mit der Erweiterung OSM-Tools) Daten importiert werden.

® Samtliche Relationen werden ubernommen und
© die Attributtierung in logisch strukturierte Spalten GUbernommen
% Erlauterungen zu den Werkzeugen auf den nachsten Seiten!
&
N
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B Alternativen zum Direktimport: spatialite_osm_map
.. spatialite_osm_map ist ein Kommandozeilenprogramm aus den Spatialite- Tools, welches eine
- OSM-Datei in eine SpatialLite-Datenbank importiert.
R http.//www.gaia-gis.it/gaia-sins/

Download http.//www.qgaia-gis.it/gaia-sins/windows-bin-x86/

laden Sie spati alite_osm nap. exe herunter
Xy Kopieren Sie die Datei in den Ordner, in welchem sich lhre OSM-Datei befindet
Offnen Sie ein Kommandzeilenfenster

(Startmenii < Programme > Zubeh6r > Eingabeaufforderung)
® wechseln Sie mit cd Verzeichnis in das Verzeichnis mit den Daten und dem Programm
% anschlieBend auf der Kommandozeile folgenden Befehl ausfuhren:
f’;‘& Spatialite osm nap.exe -0 .osm -d .sqlite
iﬁ Die resultierende SpatialLite-Datenbank enthalt die OSM-Daten sortiert nach Themen

b’
”

L]

[
Y“

pg_ (building, landuse, leisure etc.) = verschiedene Polygonthemen
In_(highway, waterway etc.) = verschiedene Linienthemen
pt_(place, amenity etc.) = verschiedene Punktthemen

als einzelne Layer einer SpatialLite-Datenbank

Die einzelnen Layer lassen sich ins QGIS laden und symbolisieren.
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Alternatlven zum Direktimport: Import in eine PostGls Datenbank

Der Import in eine PostGIS-Datenbank ist Methode der Wahl, wenn Sie grol3e Datenmengen
(z.B. OSM-Daten eines ganzen Landes) verarbeiten oder sichergehen mochten, dass samtliche
Relationen korrekt importiert werden.

Aullerdem setzt PostGis samtliche tag-keys in eigene Attributspalten um.

g0 o0

Von Nachteil ist, dass Sie zunachst PostGis installieren und
eine PostGis-Datenbank anlegen mussen.

Schritt 1: PostgreSQL und PostGis installieren
Herunterladen von PostgreSQL
http://www.postgresql.org/download/windows/
Bei der Installation wird das Administrationstool PgAdmin Ill sowie der Application Stack Builder, mit dem
Sie wiederun PostGis installieren konne, mitinstalliert.

1N nach der Installation von PostgreSQL fuhren Sie den Application Stack Builder aus
Start -> Programme -> PostgreSQL 8.4 -> Application Stack Builder
und wahlen unter SpatialExtensions PostGis aus.
Mit der Installation wird eine PostGis-Datenbank angelegt

reevoe

b’
”

L]
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& Alternatlven zum Direktimport: Import in eine PostGls Datenbank
,. _ Schritt 2: Eine neue Datenbank anlegen
. Offnen Sie das Adminstrationsprogramm PgAdmin lll
) Start -> Programme -> PostgreSQL 8.4 -> PgAdminllI
und legen Sie eine neue Datenbank an:
Klicken Sie im Objektbrowser: Server < postgis < datenbanken: mit der rechten Maustaste:
im erscheinenden Kontextmenu: neue Datenbank
v Legen Sie die neue Datenbank auf Grundlage der Vorlage template _postgis an
~
~ ) Schritt 3: Datenbank in QGIS anmelden e o mpor |
8 Offnen Sie im QGIS den Dialog zum hinzufiigen von PostgisDatenbanken == l
Layer > PostGis-Layer hinzufiigen ot locahos ]
& . . L : . Fort [5432 ]
_ _Kllcken Sie guf neu und fullen den Dl_alog_ aus: i o |
P Bei der Installation der Postgis-Datenbank mussten Sie ein Passwort angeben: | |ssimods  [sbschoiten B
9:3 Nehmen Sie die Eintragungen vor und testen Sie die Verbindung e {MQ }
L (%] Benutzernamen speichern . ——
> In einem nichsten Schritt importieren Sie die OSM-daten e :rb sraeem |
[ Mur im Schema '_public' nachsehen
(%] Auch geometrielose Tabelle anzeigen
| Geschiatzte Tabellenmetadaten nutzen
l oK ][ Cancel H Help l
. . UNIKASSEL Architektur
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ATternativen Zum Direktimport: |mport in eine POStGiS_Da/tenbank

Schritt 4a: osm2pgsql installieren
Zum Import in in die Postgisdatenbank bendtigen Sie das kleine Programm
osm2pgsql
http://wiki.openstreetmap.org/wiki/Osm2pgsql#Windows
laden Sie das ZipFile herunter und kopieren Sie die Dateien nach
C:\Windows\system32 oder nach
C:\Program Files (x86)\Quantum GIS Lisboa\bin

Sie konnen das Kommandzeilenprogramm uber eine QGIS-Erweiterung mit einer
grafischen Benutzeroberflache benutzen

Schritt 4b: Erweiterung OSM-Tools in QGIS installieren
Rufen Sie den Erweiterungsdialog auf:

Erweiterungen > PythonErweiterungen herunterladen > Reiter: Repositorien
Fugen Sie Uber die Schaltflache ,hinzufiigen” folgende URL hinzu:
http.//qgis.dbsgeo.com/

Wechseln Sie zum Reiter Erweiterungen und geben Sie in die Filterzeile OSM ein
Wahlen Sie OSM-Tools aus und klicken sie Installieren

Jetzt konnen Sie endlich Ihre Daten in die PostgisDatenbank importieren

N I K L &Architektur
ERSITAT /\_Stadtp'anung
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& Alternatlven zum Direktimport: Import in eine PostGls Datenbank

< . - mpo 3 into Po O5M2pgs &=

T Schritt 5: OSM-daten importieren o ER T e T

N Stellen Sie lhre aktuelle Projektansicht auf das KBS WGS 84 [615_2_Erweterung/2012/esm/elgerhaveen/dornload.osm

n On the Fly-Transformation aktivieren! [ |

Menuaufruf: OSM Tools > Import into PostGIS Y
Im erscheinenden Dialog nehmen Sie folgenden Eintrage vor: [ import usernames o
input: Ihre OSM-datei %] Stim on memory (slower)

» Database: Im Ausklappmenu die von Ihnen angelegte Datenbank wahlen - (oM imporz B
Slim on mem: Bei grofkeren Datenséatzen anklicken Frojecton
Projektion: ~ WGS 84 auswahlen e | | | — |

© Mit ,,C/Ip by current beX“, konnen Sie den Import auf die Ausdehnung der 9.30747436332,51.2193822163,0.4478327181,51,3956343856

Q aktuellen QGIS-Ansicht beschranken =

g (Nur wenn das PrOJekt an WGS 84 elngeSte”t ISt') EDsﬂliglﬁrslg‘lcIS_Z_Erweiterung_a‘ZD12_;‘0sm_a‘eIgerhausen_."cl01.'«p'nloac|.nsrr1“ -d

0SM_import2 -S "Ch\Documents and

gg Mlt Run Starten Sle den Importprozess ’:E._es'iitimngj".,leiner".,.qgis‘.,python‘.,plL|gins‘.,osm_tonls".,default.style" -w -U postgres%

A Nach dem Importprozess konnen Sie die Daten Uber osm2pgsql SVH version 0.69-21289M ﬂ

- Layer > PostGis-Layer hinzufiigen: Verbinden + hinzufiigen

e Visualisieren

Folgende Layer gibt es in der PostGis-Datenbank
planet_osm_polygon: Polygone, Flachennutzung, Gebaude etc.
planet_osm_line: Linien, Gewasser, Verkehr etc.
planet_osm_point: Punktinformationen: Behorden, geschafte etc
. . UNIKASSEL Architekt
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N

Landerweite OSM-daten beschaffen

T
-

-I‘I- 'l‘l‘
¥

OSM-Datensatze ganzer Lander
http://download.geofabrik.de/osm/europe/germany/
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B OSM-Daten in QGIS visualisieren
“ Nach dem erfolgreichen Import der OSM-Daten liegen, jeweils in der PostGis-Datenbank oder als

SpatialLite-Dateien Punkt-, Linien und Polygonlayer vor.
FUr die weitere Auseiandersetzung sind Linien (Verkehrswege, Gewasser etc.) und Polygone (Flachennutzung,
Gebaude etc.) von besonderem Interesse.

Die Sachdaten sind in der Attributtabellen je nach Import unterschiedlich organisiert:
Beim QGIS-Direktimport sind in der Spalte tags samtliche tags jedes Objektes in der Ursprungssyntax
dokumentiert, hinzu kommen die Spalten name, place, highway, landuse, waterway, railway, amenity, leisure,
tourism, learning, welche einfache Kategorisierung ermoglichen, die aber haufig nicht verlasslich gefullt sind!

>
=

Die Gebaude lassen sich nur aus der tags-Spalte extrahieren.

Beim Import Uber spatialite_osm_map.exe entstehen fur jeden tag-key unterschiedliche Layer (pg landuse,
In_highway etc, welche sich Uber die Spalte subtype entsprechend den tag-values symbolisieren lassen,
weiterhin gibt es eine Spalte name mit den Objektnamen

X0 D

Beim Import in eine PostGis-Datenbank werden samtliche tag-keys in eigene Attributspalten umgesetzt
(mehr als 50 keys). So gibt es z.B. die Attributspalten ,building®, ,landuse” etc.

.
-
Te

Infos zu den Attributen (tags) in OSM:
http://wiki.openstreetmap.org/wiki/DE:Map_Features

. . UNIKASSEL Architektur
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E] Layer = |
fa Erlauterung der Attribute nach QGIS-Direktimport
.,3: tags: OSM-Attributierung in vollstandiger Syntax
name: Eigennamen von Objekten zur Beschriftung (z.B. Stallennamen)
place: Platze
highway: Kategorisierung von Straf’en und Wegen
landuse: Flachenhafte Landnutzung
XY waterway: Gewasser
. railway: Schienenverkehr
~ amenity: Offentliche Einrichtungen, private Dienstleistungen (Kindergarten, Tankstelle, Feuerwehr etc.)
X leisure: Freizeitnutzung, wie Sportplatze, Spielplatze, Parks etc.
D) tourism: Fremdenverkehr
) learning: Bildungseinrichtungen
® Die Gebéude lassen sich nur aus der tags-Spalte extrahieren, weil es keine Spalte fiir Gebdude gibt.
?:3 Beim den beiden anderen Importverfahren sieht es anders aus.
n
Infos zu den Attributen (tags) in OSM:
http:/Iwiki.openstreetmap.org/wiki/DE:Map_Features
Online-Datenquellen mit QGIS Dr.-Ing. Claas Leiner 3 I: IR KsA| STS-AI-EI{ &%\%ﬁ%ﬁngl
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|| PKUID N timestamp user tags name place highway landuse waterway railway ;
_I ® 712011-04-05T15:4_ |paul?? "highway"'="secondany","maxspeed"="80","name"="Wittmunder Stralle","ref"="L808" Wittmunder Stralle secondary
i 7 8| 2011-11-27T13:5_ | paul77 "addrpostcode”="26441" "highway"'="secondary”,"maxspeed"="50", "name"="Elisabethufer","ref"="L 813" Elisabethufer secondary i
e 9(201005-17T09:4_ |masju = Team "highway"="secondany","maxspeed"="70""ref"="L 812" secondary
‘:l 9 10| 2010:08-21T10:0_ | masju + Team "highway"="residential","name"="Am Bullhamm","source"="survey" Am Bullhamm residential
; 10 11| 2010-06-25T07:2_ | Latze "highway"'="tertiany”,"maxspeed"="50","name"="Rahrdumer Strale","ref"="K 332" Rahrdumer Strale tertiany
11 12| 201005-17T18:5_ | GPS-Walf "highway"="tertiary”,"maxspeed"="70","name"="Jeversche Strale","ref"="K 94" Jeversche Stralle tertiany
712 13 201007-11T15:2_ | GPS-Wolf "bridge"="yes","highway"="secondany" "layer"="1" "maxspeed"="70" "ref"="L 812" secondary
_‘ 13 14| 2011-10-12T14:3_ | paul77 "highway"="tertiany”,"maxspeed"="50","name"="Hlisabethufer" "postal_code"="26441" Elisabethufer tertiany
114 15| 201102-13T10:2_ | hemann51 secondany”,"maxspeed "name"="Wittmunder Stralie”,"ref"="L 808" Wittmunder Stralle secondary
15 16| 2010-08-02T16:3_ | GPS-Woalf runk_link","oneway"'="yes" trunk_link
'E 16 17 | 2005-08-10T06:2_ | GPS-Woalf "highway"'="tertiary”,"maxspeed"="50","name"="Grashausweg","postal_code"="26441" Grashausweg tertiany
=l K 18 | 2010-05-01T07:3_ | OSchliter "highway"="tertiary”,"maxspeed"="50","name"="Ziegelhofstralle”,"postal_code"="26441" Ziegelhofstralie tertiany
T 18 19| 201201-30T08:4_ | Latze secondany”,"maxspeed" L 808" secondary
o (159 20| 201102-13T10:2_ | hemann&1 "bridge"'="yes","highway"'="secondary”,"layer"="1","maxspeed"="80","name"="Wittmunder Strale","ref"="L808" Wittmunder Stralle secondary
:l 20 21| 2011-10-12T16:0_ | paul77 "highway"="unclassified","maxspeed"="50","name"="Grolle Wassempfortstrale", "suface"="paved" Grolie Wassempfor_ unclassified
ﬂc 4 I I

@Emmmnam[

5[] Mur gewshlte zeigen [ | Mur gewshlte durchsuchen (%] GroB-/Kleinschreibung beachten

Viam

| £ 2 o o o o e 3 —— 7 =15 1 =

e gewahit

4 user tags name place highway landuse [

215 133 | 2010:09-14T16:4_ |masju + Team "landuse"="village_green" village_green —
220 255 | 2010-05-14T16:4_ |masju + Team "leisure"="minizture_gol™ | |
27 193 | 2010-09-14T16:5_ |masju + Team "addrcity"="Jever","addr.country”="DE","addr housenumber"="13","addrpostcode"="26441" "addr:street"="Am Kirchplatz","building"="yes","'name"="Gemeindehaus" Gemeindehaus
237 281 | 2010-09-14T16:5_ |masju + Team " "addrhousenumber”="2" "addrpostcode”="26441","addr:street"="Kummellenbogenstralie”, "building "="yes"
277 191 | 2010-09-14T16:5_ |masju + Team ' "addrhousenumber”="16" "addrpostcode"="26441","addr:street"="Am Kirchplatz","building"="yes","name"="Ev. Pfamamt" Ev. Pfamamt
224 250 | 2010-09-14T16:5_ |masju + Team “addrcty”="Jever" "addr.country”"="DE","addrhousenumber "addrpostcode”="26441" "addrstreet rolie Rosmarinstrale”,"building”="yes"
225 59 (2010-09-14T16:5_ [masju + Team “addrcty”="Jever","addr.country"="DE","addrhousenumber"="2" "addrpostcode"="26441","addr:street"="Kummellenbogenstralie”, "amenity"="place _of _worship”,"buiding"="yes" "de_ | 5t. Marien
276 275 | 2010-09-14T20:2_ |masju + Team
237 92 (2010-09-14T20:3_ |masju + Team " "addrhousenumber”="18" "addrpostcode"="26441" "addr:street"="Alter Markt","building"="yes","name"="Tourist-Information Jever","phone”="_ | Tounst-Informatio_
228 | 282(2010-09-14T20:3_ |masju + Team
E 283 | 2010-09-14T20:3_ |masju + Team “landuse™="village_green" village_green
230 3(2010:09-14T20:3_ |masju + Team “highway"="residential”,"maxspeed”="30","name"="Am Kirchplatz”,"oneway"="yes","postal_code"="26441" Am Kirchplatz residential
F 284 | 2010-09-14T20:3_ |masju + Team “leisure"="garden"
232 7(2010:09-15T00:4_ |xybot “amenity” arking”,"capacity”'="20","capacity disabled"="no","capacity parent"="no","capacity women"="no","fee"="no", "parking"="surface™, "park_nde"="no" Y
223 23 (2010:09-15T01:1_ |xybot “amenity”="parking","capacity:disabled"="yes","fee"="yes","parking"="surface™ E
| | K10
E @ [j Suchen nach ] in [name "] Suchen
| Mur gewshlte zeigen ] Mur gewdhite durchsuchen (3] Grofi-Kleinschreibung beachten [Erweiherbe Suche ] [ ?
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| ) DE:Map Features - OpenStreetMap Wiki - Mozilla Firefox

. Datel Bearbeiten Ansicht

Chronik  Lesezeichen

Extras Hilfe

;@ - @ . |» |nttpiwiki openstreetmap.orgiwikiiDE:Map_Features B

Google 2

|2 Meistbesuchte Seiten | | Erste Schritte =

Aktuelle Nachrichten

4

Google _ ] ] http:__qgsl | ] Leinever_

. Steuem _| % Downloa_ | | DAVKa_ | *§ Google | (& gspatiali | fo fowid - F_| & Hessisc_ | *J Google | , DE_ @@ |, OpenStr > |-

landuse farmyard @ Unterstanden, Stallen, Fahrzeughallen, Futterspeichern usw. Ebenso die Flachen zwischen
den Gebduden, sowie nahe Baume, Hecken und Grinflichen.
Forst, Landwirtschaftlich genutzer Wald. Die meisten Walder in Deutschland und in der
Schweiz sind forstwirtschaftlich genutzt. Nur vollkkommen unbewirtschaftete Wélder
(Urwaldzonen) sollten mit natural=wood getagged werden. Die Tags nie gleichzeitig -_—
landuse forest B @ verwenden.
Zur Unterscheidung der Baumarten kann zusatzlich das tag -
wood=coniferous/deciduocus/mixed fUr Nadel-, Laub- oder Mischwald gesetzt
werden.
landuse garages @ Garagen auf gréferer Flache, Garagenhof, nicht fir Einzelgarage by <58
SR
! Rasenfliche
landuse | grass (&4 Vorzugsweise innerorts. Fir Weideland und Wiesen siehe 1anduse=meadow.
) Bauerwartungsland, unerschlossenes, fiir Bebauung vorgesehenes Land (Keine
. landuse | greenfield [«]F3 g
landuse greenhouse_horticulture @ Gewichshaus-Fliche
=
landuse | industrial [¢]F% | Gewerbe-findustriegebiet (iiberwiegend Werkstatten, Fabriken oder Lagerhallen)
landuse | landil [¢]F% | Deponie, Aufschittung, Mallhalde
Wiese, meist auierorts (im Gegensatz 7u landuse=village green nicht explizit fir
landuse meadow -
B @ ffentliche Zwecke, z B. Veranstaltungen, vorgesehen)
=l

| Fertig
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¥) DE-Tag-landuse=grass - OpenSireetMap Wiki - Mozilla Firefox

. Datei

Ansicht Chronik Lesezeichen Extras Hilfe

b T8} P SIWIKL.Openstreetmap.org/wikl Clagilanduse’o rass
. ¢ X http-//wiki.openstrestmap.org/wiki/DE Tag-landuse%3Dg

By - | |*8=] Google

.| Meistbesuchte Seiten || Erste Schritte - Aktuelle Nachrichten

+/Google | | http-.qgs| || Leinever.  Steuemn _| g Downloa. | |DAVKa. *JGoogle | ¢ gspatiali | fo fowid - F_| 3 Hessisc. | *§ Google | . DE:T_@ |, OpenStr_|: |-

DE  Discussion Read WView source View history

& Login/ create account® —

Q

‘ Find out more about OpenStreetMap's upcoming license change (translations) (discussion)

DE:Tag:landuse=grass

Main Page |
The map Available languages Help|
Mapping projects - Deutsch - English - Francais « Nederlands - Portugués do Brasil « Pycckuit
Map Features Other languages show|
Contributors Allgemein eine innerdrtliche Flache auf der Gras wachst. Dies kann auch eine Wiese in einem Park, Grinflichen auf einem Golfplatz, in einem
Help Kreisverkehr usw. sein. Wenn weitere Differenzierungen moéglich sind, sollten statt landuse=grass besser beschreibende Tags genutzt E} landuse=grass +i-
Blog werden. So sollen ZB. keine landwirtschaftlich genutzte Wiesen und Weideflichen mit diesem Tag erfadt werden. Statt dessen ist e "
Shop landuse=meadow Ublich. Dies gilt auch fir Wiesen oder Grunflachen in Waldlichtungen, die in deutschen Forstgebieten oftmals gezielt S
I — als Wildweiden angelegt werden.
In der deutschen Community gab es wiederholt Diskussionen, ob das Taggen von Grasland sinnvoll ist. Es wird die Meinung vertreten, wenn
Recent changes Grasland die vorherrschende Landschaftsform ist, muss Grasland im Gegensatz zu Waldflachen nicht extra ausgewiesen werden. Der
~ Toolbox Standpunkt, es sei daher nicht notwendig, die Flachen zu taggen, ist umstritten, weil das Ausweisen solcher Flachen eigentlich eine Frage des
What links here Kartenlayouts/Renderns ist. (Diskussionen bitte auf die Diskussionsseite)
Related changes . Beschreibung —
Special pages spezifischere Tags Rasenfliche
Printable version Fr im Allgemeinen mit Gras bewachsene Flachen existieren unter Umstanden spezifischere Tags, die die Situation besser beschreiben, Vorzugsweise innerorts. Far
Permanent link darunter: Weideland und Wiesen siehe
Cite this page : _ ) o . ) ; ) o ) ) ) landuse=meadow.
+ leisure=garden Eine kultivierte Fldche mit Blumen, Blschen und Baumen, die privat oder dffentlich genutzt wird.
o leisure=golf course Eine Landflache, die zum Golfspielen genutzt wird. (siehe ferner:\Vorschidge fir neue Golf-Tags) 0 EegyESNIENG
+ landuse=meadow Vorgesehen fir landwirtschaftlich genutzie Wiesen. o BRI fE=DE RN
o leisure=park Ein zu Ernolungszwecken der Offentlichkeit zugangliches Areal innerhalb eines Siedlungsgebietes. Elementihilic
s leisure=pitch Eine zur Ausiibung bestimmter Sportarten vorgesehene Landflache, z.b. ( Tennis, FuBball...) E] '?
« landuse=recreation ground Eine zur Ausiibung informeller Sportarten sowie zu allgemeinen Unterhaltungszwecken ’
vorgesehene Landflache. Nitzliche Kombination
Andere Mégliche Tags: Impliziert =
| Fertig y
. . UNIKASSEL &Architektur
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¥) DE-Tag-highway=residential - OpenStreetMap Wiki - M la Firefox

Datei Bearbeiten Ansicht Chronik Lesezeichen Extras Hilfe

ij - C X |» | http://wiki.openstreetmap.org/wiki/DE: Tag:highway%3Dresidential

Meistbesuchte Seiten | | Erste Schritte - Aktuelle Nachrichten

Google - | | http-_qgs | Leinever |  Steuem_| (% Downloa. ‘| DAVKa | *JGoogle | ¢} qspatiali | fofowid-F_| i Hessisc. | *JGooge | , DET_g@ |, OpenStr
i

_p\ ind out more about OpenStreetiap's upcoming license change (translations) (discussion) [ 4l

| DE:Tag:highway=residential

Bty - |[[*8:]Google P

4

]

i Main Page
| Themap Available languages Help
i Mapping projects + Deutsch - English » Francais - ltaliano - §#3E - Portugués do Brasil = Pycckuii » YkpaiHcbka
i Other languages show|
|| Map Features
| Contributors
| Hep Dieses Tag wird fiir Strafien benutzt, die den Zugang zu Wohngebieten erméglichen, aber nicht zu den klassifizierten oder
Blog highway=unclassified Straten gehdren.
Shop Das folgende ist eine Hilfestellung, fir den Fall, dass man sich nicht sicher ist, ob eine Strake innerhalb eines Ortes als "residential” oder
Donations "unclassified" getaggt werden sollte:

Recent changes s unclassified - eine etwas breitere Stralte, die fiir Durchgangsverkehr genutzt wird.

« Toolbox « residential - eine schmalere Strate, die eigentlich nur von Leuten benutzt wird, die an ihr wohnen oder an einer der Stralen, die davon
What links here abgenen.
Siehe auch:

Related changes

Beschreibung

Special pages
Printable version

Permanent link - I . . N .
S Wie man die Stralle eintragt « Google-Definition &
Cite this page

; » Benutzer-Diskussion
Um eine Wohngebietsstralie einzuiragen braucht man nur einen Weg zu erstellen und das Tag Element Hilfe
27 highway=residential zu seizen. Ein name=*-Tag ware auch noch schon, wenn man den Straennamen kennt. E]

s highway=1living street - eine Strake, in der FuBgénger Vorrecht vor Autos haben (Spielstraie). Die erlaubte

Héchstgeschwindigkeit ist Schrittgeschwindigkeit. Straften in Wohngebieten

?

Beispiele Niitzliche Kombination —

s name=*

Bild / Beschreibung Tags Mapnik Osmarender * oneway=*

ein Weg mit Impliziert

highway=residential

eine einfache Wohngebietsstrake taginfo [More. ]

name=Humboldtstrale B 65040 0.25%
@ 21919080 4575%

Verwandte Begriffe: Wohngebietsstrasse.

570 11.23%

| Fertig

=
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Stadt Jever, Innenstadt aus OSM-Daten

!

g
£
o
I
F’
{
{

|
; \Wasserpfortstral®

eASwneauaPUT

e Ot

N
-~ Schiopstra™®

S ——: 4‘

Datenvisualisierung: Dr,-Ing. Claas Leiner

Daten von OpenStreetMap - lizensiert unter CC-BY-SA 2.0
Quelle: http://iwww.openstreetmap.org/
Lizenz: http://creativecommons.org/licenses/by-sa/2.0/

Legende

Verkehr
=== Durchgangsstrafte
Hauptstralie
—— Stral3e, innerorts
= Erschliefung
—— Verkehrsberuhigt
1 Fullgangerzone
—— Radweg
—— Fullweg

Flachennutzung

Siedlungsflache, allgemein

B Besondere Gebaude
Sonstige Gebaude
Bildungseinrichtung
Platz

Parkplatz

Griunflachen, allgemein
++- Friedhof
B Schiosspark
Spielplatz
I Freizeit und Sport
' Stadion
Landwirtschaft

B Wald
I Gewasser




Datenvisualisierung: Dr.-Ing. Claas Leiner

Daten von OpenStreetMap - lizensiert unter CC-BY-SA 2.0
Quelle: http://www.openstreetmap.org/
Lizenz: http://creativecommons.org/licenses/by-sa/2.0/

Legende

Verkehr
=== Autostralle

= Bundesstralie

== Durchgangsstral3e
Hauptstralie

= Stralde, innerorts

== Fullgangerzone

= Verkehrsberuhigt

~— Erschlieffung

—— Radweg

——— Fullweg

—— Bahn

Flachennutzung
Siedlungsflache, allgemein

Gewerbegebiet
Bl Besondere Gebaude
Sonstige Gebaude
Bildungseinrichtung
Platz
Parkplatz
Granflachen, allgemein
=+ Friedhof
B Schlosspark
Spielplatz
I Freizeit und Sport

Landwirtschaft
El Wald
P Gewasser

—— Graben / Tiefs
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OSM-Daten in QGIS visualisieren

Um die OSM-Daten im GIS in eine sinnvolle Karte umzusetzen, ist es notwendig fur die
Kategorisierung mehrere Attributspalten auszuwerten (z.B. landuse, building, amenity, leisure)
bzw. die tags-Spalte mit Hilfe von Ahnlichkeits-Abfragen direkt auszuwerten.

Diese Vorgehensweise ist bei den Polygonlayern praktisch zwingend, weil es sonst nicht
moglich ist z.B. Gebaude und Landnutzung gleichzeitig darzustellen (aul3er sie liegen in
verschiedenen Layern vor). Will man bei den Linienlayern nur die Strallen und Wege
visualisieren, reicht die Spalte ,highway”

Die Umsetzung erfolgt mit Hilfe der regelbasierten Darstellung und der Anwendung von
Symbolebenen. Mit der regelbasierten Darstellung, lassen sich Kategorien anhand von Regeln
bestimmen, die sowohl SQL-Abfragen als auch Kategorisierungen und abgestufte Klassifikationen in
einer Symbolisierungsvorschrift kombinieren. Das heil3t, die Symbolisierung eines Layers kann
Inhalte verschiedener Attributspalten visualisieren.

Die Vorgehensweise im Detail wird einige Seiten spater darggestelit.

Infos zu den Attributen (tags) in OSM:
Die inhaltliche Bedeutung der tag-key und lhrer Werte ist ausfuhrlich auf den
Seiten des OSM-Projektes dokumentiert:

http://wiki.openstreetmap.org/wiki/DE:Map_Features
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OSM-Daten in QGIS visualisieren
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Layer = |

Regelbasierte Darstellung

Regelbasiert bedeutet, dass die dargestellten Kategorien
uber eine Attributabfrage definiert werden.

Sie finden die regelbasierte Darstellung uber:
Layer > Eigenschaften > Stil (Neue Darstellung): Regelbasierend im Pulldownmenii auswahlen
Neue Regel hinzufuigen: Schaltflache hinzufiigen klicken:
Hinter Beschriftung: Namen der neuen Regel eintragen (Grunflache etc.)
Attribut-Abfrageeditor 6ffnen, um die Regel zu erstellen: Schaltflache hinter ,Filter”
(Siehe Folien zur Bedienung des Attributabfrage-Editors)

Regeln konnen definiert werden durch:
x SQL-Abfragen / Case-Bedingungen (Filter)
x Malstabdefinitionen
x Kategorisierungen nach eindeutigen Werte (Regel verfeinern > Kategorien)
x Bereiche mit abgestufter Symbolisierung (Bereich hinzufiigen)
Online-Datenquellen mit QGIS Dr.-Ing. Claas Leiner VERSI AT &éﬁﬂiﬁﬁfng
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OSM-Daten in QGIS visualisieren il
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Layer [

Regelbasierte Darstellung nur in der ,,Neuen Darstellung” in QGIS

Zur ,Neuen Darstellung“

{; Layereigenschaften - Nutzung EHE
a Stil I Beschriftungen " Felder '%& Allgemein LID Metadaten E‘}Q} Aktionen "'<:i 'u'erknTE
Legendentyp [Einze|5?mbg| vl Transparenz: 0% C ] [ Meue Darstellung +

Beschriftung
—Fiilloptionen
—Imrandungsoptionen
[— |v]DBreite[D.26 =
[ Stilvorgaben wiederherstellen ] [ Als Yorgabe speichern ] [ Stil laden. .. ] [ Stil speichern... ]
[ Ok ] l Cancel ] [ Apply ] l Help ]

umschalten

Zur neuen Darstellung muss unter
Layer > Eigenschaften > Stil
umgeschaltet werden!
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OSM-Daten in QGIS V|suaI|S|eren

i IS I R+ § ?E PP PCPE R Q Y e @R ”n EL Q@ PO
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Layer | s =
B Regelbasierte Darstellung: Kurziibersicht
) Regelbasiert bedeutet, dass die dargestellten Kategorien
N uber eine Attributabfrage definiert werden.
= Sie finden die regelbasierte Darstellung uber:
ayer > Eigenschaften > Stil (Neue Darstellung): Regelbasierend im Pulldownment(i auswahlen
Neue Regel hinzufiuigen: Schaltflache hinzufiigen klicken:
Hinter Beschriftung: Namen der neuen Regel eintragen (Grunflache etc.)
XY Ausdrucks-Editor 6ffnen, um die Regel zu ekstellen: Schaltflache hinter ,Filter”
Beschriftung [ ]
ﬁ Fitter [ ] [ Testen |
@ Beschrelbung | J
[ Malistabsbereich
& [ Min. Mafstab [1: 000 | M nrtn\
] Spielplatz tags LIKE “play rn:I —Symbol
ga SymbOIebenen .gh\stngrkb tnagmeUKE; hf IdPgrk e .
& | (Siehe Folien | |« i i Symbolisierung
) hinter dem St o e s U —  bearbeiten
I N Thema e -
Abfrageeditor) | \gzuo m N — |
- |ZEnEN il
T EEAEEr ] immmn | E]
I Verhalten [%] Symbolebenen aktivieren 3] Hur erst de Regel I
[ stivorgeben wiederherstelen | | Als Vorgabe speichern Il Stil ladk Il Stil speich |
. . UNIKASSEL Architekt
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OSM-Daten in QGIS regelbasiert visualisieren
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Layer

Einzelne Regel:
Besondere Gebaude

L —

RREL PP RP
FTVRLY DIE

A\

Ausdruckseditor
(wie Feldrechnner)
um
Abfragen, Bedingungen
und Berechnungen
zu erstellen

Fertiger Ausdruck

{; Layereigenschaften - Pol

T ™o Q2
" BE N

o

L

TEeean [ L ws PO
Seaa 1@ Se@ O [dlaldldI0]
I

wf stil | [ Beschriftungen |

: Felder | ", Allgemein | @Metadaten | @Ahionen | 4Verknﬁpfungen | ?.LIDiagramme | LIUberlagernl

Regebaserend ]~}

Alte Darstellung

Label

| Rule

| Min. scale | Max scale

=] Geb

. Gebaude besonders
;/. Gebaude normal

Nutzung

i Waohngebiet
gewerbe
Baustelle
Parkplatz

-+ Friedhof
Kleingarten
Landwirtschaft
Griinland

-l Wald

. "landuse" = 'retail'
E amnety

E Feuerwehr
Tankstelle
- Kindergarten
-l Schule

-l Kirche

= . Freizeit / Spart
=| Tennis
Sporiplatz

Lo @] Spielplatz

Regenrickhaltebecken

"tags LIKE '%building'

=
"tags"

%g

ebuilding®' AND "name"
(no filter)
"landuse" = 'residential'
"landuse" = 'commercial' OR "tags
"landuse" = 'construction’
"amenity" = 'parking’
"landuse" = 'cemetery’
"landuse" = 'allotments’'
"landuse"in (‘farm'. farmland' . ‘farmyard'}
"landuse" in (meadow!, 'greenfield’, 'grass')
"landuse" = 'forest'
"landuse" = 'basin’'
"landuse" = 'retail’
"amenity" IS NOT NULL
"amenity" = 'fire_station’
"amenity" = ‘fuel'
"amenity" = 'kindergarten’
"amenity" = 'school'
"amenity" = 'place_of worship'

"tags" LIKE '%leisure™'
"tags" LIKE '%tennis%'
"tags" LIKE '%pitch%'
"tags" LIKE '%playgrounds'

4 Ausdruckseditor [ %]

" LIKE '%cbuilding%:' AND ("‘Iags LIKE %name%' OR "tags" LIKE '%school%' OR NOT "name" ="}

enerator¥’

i Regeleigen- _haften

Regelbeschriftung

Beschriftung [Gebaude besonders - L—"J
Fiter [rme% OR "tags™ LIKE "school% OR NOT “name” = ") | I ‘H/T ten ]

Beschreibung [O'Fﬂanﬂ\d've und andere besondere Gebiude l

[ Maitabebereich

Min. Mafstab [1: 1000 B Mex. Mafistab [1: 1000 =]
(%] symbol
S

B

Transparenz 0% (——

2y

Farbe

Filter =
SQL-Abfragung
Case-Bedingung

Berechnung

Gespeicherte Stile

#H

L] D ++++ [ E

Online-Datenquellen mit QGIS

Funktionsliste Hilfe zur gewahlten Funkton ————
Suchen| Feld [}
- e
22 5 Klicken Sie den Feldnamen doppett um hn |27
- demAusdruck hinzuzufigen
I/ ’/’71; Per Rechtsklick auf den Feldnamen
-l // < kiinnen Sie ein Kontextmend mit Optionen
- Feldwerte
= d »= N &
‘allotments” i
LIKE basin’ B
- ILIKE ‘cemetery”
] ‘commercial’ L
OR ‘construction’
- AND 21 |fam’
-NOT x| |Tamland'
Operatoren
L) = D]
Ausdruck
"tags™ LIKE "%%building®" AND ("tags”™ LIKE '%tname®:' OR "tags™ LIKE '%tschool®:' OR
||| e = ")
L1
//[
{

Ausgabevoransicht:

o J[ ona |

|G

Zeichenreihenfolge...

stil laden... ] [ Stil speichern... ]

(o ) o ] oo ] [_vew ]
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24 RRELPPE LRE®DQ O meemk [ caa s Uil 0
©Ll:2 8@ s""dRNaE N =R g vz "FE - -Saadeée 1@ S@O [dleldld 107 -G
E] == & |
— Schritt 1: Regel definieren
E Layereigenschaften - Pol -
? &y’ stil I [=% Beschr'rﬂungen—| = Felder—| -‘Allgemein—| @Metadaten—| @Ahionen—| {ZE RegelbeSChriftung \\ e'enschaﬂe" L
3 I__>Be riftung | Landnutzung
‘n | | (Reselbaserend -] — e |
Label [ Rule [in. scale | max scalo— — | Besdhreibung |
RS LR 11T Filter - [ mastabsbereich
N (Inhalt der Regel) e T Mo, Moo
r 3] Symbol
e Doppelklick

Einheit Millirme ter

zu den [Milimeter [~
i spa —_—

Regeleigenschaften Transparenz 0%

o
e | —

Gespeicherte Stile 5

/—
Zum

Symbolisierungsdialog m - . . H

BBVO

& 1 Hinzuf[igenl l } Bearheitenl li-—Z Entfernenl lAklueIIe Regeln verfeinern "l lZeichenreihenfolge...l E
A 2 3 2] [II]]] D N+t 7777 I
lStiIvorgahen wiederherstellen] l Als Vorgabe speichern l l Stil laden... l l Stil speichern... l
:’: l oK l l Cancel l l Apply l l Help l ’ — ] [ — l
Dialog
Regeleigenschaften
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24 RRELPPE LRE®DQ O meemk [ caa s
©L)*“ B RDaE X =R e vr "EN - DSa@ds 1@ S@O [dieldld I |
Layer &= |
@ Schritt 2: Bedingungen der Regel definieren

v
N ) N
S etasamaln Al — / Ausdruckseditor 21x]
A Besdhriftung | Landnutzul
L riftung |Landnutzung 1 Funktionslistz Hilfe zur gewahlten Funktion
o, Fite R = Sucher| J [Ferd

Beschreibu o=
W=l LI, [ / \\ ] oy B Klicken Sie den Feldnamen doppelt um Ihn dem
r (] MaBstabsbereich \ gl Ausdruck hinzuzufigen.
' - =] -+ % = . e -
Min. Mafstab Max. MEBS/L' L} 1000 3 Funktionen des Per Rechtsklick auf den Feldnamen kinnen Sie gin E
B Syl I/ \\ Ausdruckseditors - Feldwerte
- LIKE . -
) - ‘allatments’
XY Enheit pwmetr _|+] | Ausdrucksseditor e basi t
Transparenz 0% [ )=' offnen SED Esz::g;d
Forbe - NOT F ‘construction’ E
Bt Mathematilc 1 |fam’ hd

. - Operatoren
3 ananonnnn
(5%) m - - . H Rl
) Fertige NOT " ="
& B L0111 —— e o e Bedingung A
Ausgabevoransicht:
n [ o ][ caa ] / \ 0K H Cancel

)\

Bsp: Kein leerer Wert in der Spalte
Alle Objekte mit einem Wert
in der Spalte werden angezeigt
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1 dd - RBRREFPPSE hRuWQ ' OEaff8&k DAL T AR PO
©L) B @i " R & F =0 & & = "EE - 2ad@d 1@ S@ ' [dleldld 0]
Layer [
[o) Schritt 2a: Bedingungen der Regel definieren
1:b
&
- Ausdruckseditor E
‘Q Funktionsliste Hilfe zur gewahlten Funktion
Suchen[ _] Feld
E Klicken Sie den Feldnamen doppel um lhn dem
Ausdruck hinzuzufigen. (t Layereigensdlaften — Pol E
Per Rechtsklick auf den Feldnamen kiinnen Sie ein E — = 5
| Stil { Beschriftungen ‘ Felder ‘ , Allgemein ‘ {1} metadaten ‘ g+ Aktionen | {I
- LIKE - -
Ky - ILIKE ‘Sllotments’ t [Regelbasierend |'l
|5 :basin' .
SSD — -Eﬁﬁggiar — |Ru|e |Min. scale |Max.sca|e
- NOT [; ‘Construction’ E Landnutzung NOT "landuse” = "
B Mathematils fam
. QOperataeren M
Rl EnEnnnn I r—
@ Ausdruck - ge eintache ~nege
% NOT "landuse™ = " /
) | (D]
{Q‘B NOT " "=" & Hinzuﬂ.igenl [ Eearbeiten] [E Entfernen] [Aktuelle Regeln verfeinern *] [Zeichenreihenfolge...l
b A
Ausgabevoransight: [Stiworgaben wiederherstellen” Als Vorgabe spaichern H stil laden... H Stil speichern... l
- 0K ]’ Cancel l OK ]l Cancel ][ Apply ll Help l
:’- \
Kein leerer Wert in der Spalte
Alle Objekte mit einem Wert
in der Spalte werden angezeigt
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444 - RR/RELLLRPE L RE&®HRQ ' C ggesean [P es PO
OCR-“B@ s " AR =D w = "B -Saadd J@.. S@O 344 J30] L
Leyer = | TR
%] Exkurs: SQL Operatoren und Syntax-Regeln zur Formulierung von Bedingunge
& Grundsatzlich
& Textwerte sind in Hochkommas (') einzurahmen / Abfragen lassen sich mit Klammern () strukturieren / Als
A4 Platzhalter gelten _ fUr ein beliebiges Zeichen und % fur eine unbestimmte Anzahl beliebiger Zeichen
= GroBenvergleiche
Die Operatoren =, >, <, <=, >= sind selbsterklarend
Bsp: Nutz = Wald (Alle Objekte, fiir die als Attribut der Spalte Nutz der Wert 'Wald' zu finden ist)
Bsp: FL_ha > 12 (Alle Objekte fur die Attribut der Spalte FL_ha ein Wert groRer als 12 zu finden ist)
X Vergleich auf Ahnlichkeiten
Mit dem Operator LIKE Ahnlichkeiten finden
Bsp: NAME LIKE '%Fulda%' (Findet alle Objekte mit 'Fulda' im Namen, z.B. Fulda, Fuldabriick, Rothenburg a. d. Fulda)
L o) (ILIKE brucksichtigt grof3- und Kleinschreibung)
O Suche iiber Aufzihlungen
& Mit dem Operator IN gesuchte Werte aufzahlen
% Bsp: OBJEKTART IN ('"Wohnbauflache','Gewerbeflache','Flache gemischter Nutzung')
;\ Findet alle Objekte, bei denen einer der aufgezahlten Werte in der genannten Spalte vorkommt.
Fragen verknupfen
N Mit dem Operator OR, AND und NOT Abfragen Uber verschiedene Attribute verknupfen
Bsp: GEMNR >=611000 AND NOT N_KREIS = 'Landkreis Fulda' AND (EINWO_ZA > 10000 OR EinwQKM > 303)
Findet alle Gemeinden mit einer hdheren Gemeindenummer als 611000 (RP Kassel), die gleichzeitig nicht zum Landkreis
Fulda gehoren und entweder mehr als 10000 Einwohner oder Uber eine hohere Bevdichte als 303 Einw je Qkm verfugen.
NoData_ Felder finden-Werte finden mit IS NULL
Bsp: GEMNR IS NULL
Online-Datenquellen mit QGIS Dr.-Ing. Claas Leiner v ER KsAn TAT &%ﬁ%‘hﬂﬁ%ﬁgﬁ,,&mg
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Belsplele fur Regeln zur Visualisierung anhand der tags-Spalte

Regeln mit Abfrageeditor erstellen
Beispiel:

(tags LIKE '"%leisure%' OR tags LIKE '%village_green%') AND (NOT tags LIKE '%park%') AND ( NOT tags LIKE '"%pitch%")

AND ( NOT tags LIKE '"%playground%")

In der dargestellten Regel werden alle stadtischen Griunflachen dargestellt werden,
die weder Parks, noch Sport- oder Spielplatze sind:
Die tags leisure (Freizeit) und village_green umfassen samtliche stadtischen Grunflachen

tags LIKE '%leisure%' OR tags LIKE '%village_green%') Bedeutet:
samtliche Objekte darstellen, bei denen in der Attributspalte ,tags” die Begriffe ,leisure” oder ,village_green“ vorkommen.

AND (NOT tags LIKE "%park%') AND ( NOT tags LIKE '"%pitch%') AND ( NOT tags LIKE '%playground%') bedeutet:
Ausgenommen von der Darstellung sind samtliche Objekte, bei denen in der Attributspalte ,tags“ die Begriffe ,park®, ,pitch®
(Sport) oder ,playground” vorkommen

Die Spielpléatze werden separat dargestellt mit der Regel: tags LIKE '"%playground%'
Freibad und Sportstatten werden mit folgender Regel dargestellt:
landuse = 'recreation_ground' OR tags LIKE '"%pitch%' AND (NOT tags LIKE '%athletics%')
Wobei der tag ,athletics” (Stadion) ausgenommen wird, um mit der Regel: tags LIKE '%athletics %'
das Stadionoval Uber dem Sportgelande seperat darstellen zu kénnen:

Weitere Erlauterungen zum Abfrageeditor:
Siehe folgende Folien

. . UNIKASSEL Architekt
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4 14 _ RRBREL PP P E L RE® s Jmseaa [Pl es PO
©WL:2BEsE""dhRNa XL =R e v *"FE - -Saa@de 8. @O [dleldldldld
Layer = |
"~ Exkurs: Funktionen des ,,Ausdrucksseditors*
N Der ,,Ausdrucksseditors ist in seinen Funktionen identisch mit dem Feldrechner
w
Funktonsliste Hilfe zur gewahlten Funktion
Suchen | [Feld
- B
Sk LIKE o
S
~OR
Funktionen zur Erstellung der Ausdriicke: - - AND
® Berechnen und abfragen - Mathematit | Feldwerts
© S :
£ 5 G R
E;tder_ll.?;d Werte -
) Felder und Werte auswahlen — ZtEuIE
s = 2
- Schnellauswahl wichtiger Operatoren e =
:P: g P \~ Operatoren
HEE NN
Zu berechnender Ausdruck / Bbedingung — A::‘;"jhen S —
Ausgabevoransicht:
oK ][ Cancel ][ Help
. . UNIKASSEL Architektur
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1 dd - RBRREFPPSE hRuWQ
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I 9@ & &N
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i . / ‘m,v
= - - -+ TN e e
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{} Feldrechner - E

[] Mur ausgewahlte Objekte aktualisieren

[3€] Neues Feld anlegen [] vorhandenes Feld erneuern

Ausgabefeldname [ AL |
Ausgabefeldtyp [Ganzzahl (integer) | v]

Ausgabefeldbreite E Genauigkeit mg

[ zeile

Funktionsliste
Suchen ]

Hilfe zur gewahlten Funkton
Feld

- [LIKE
- NQT
[ Mathematilc
- Umwandlungen
H Zeichenketten
B Geometrie
[ Datensatz
- Felder und Werte
i zeile
i gtud

Feldwerte

Lo T=

’Eﬂr 'Spalten verketten E

Operatoren

l=d]lck+ll-]lf]l*][*]["][{][i]

Case when "verk™ = '4' then “entf” End

Ausgabevoransicht:

o [ o [ v |

Exkurs: Beispiele fur Ausdriicke U

Berechnen einer neuen Attributspalte aus
vorhandenen Attributen:
Bsp: Bevolkerungsdichte in Einw/gkm
EINWOH_ZA / FLAECHE_HA* 100

Konvertieren von FlieBRBkommazahl zu Ganzzahl
to int ( Spaltenname)

Konvertieren von Text zu Ganzzahl
to int ( Spaltenname)

Eintragen von Textwerten in ausgewahlte Spalten
Ankreuzen: Nur ausgewahlte Objekte aktualisieren
Feldrechnerausdruck: 'text’
Feldrechnerausdruck ArcGis: “text

Flache der Objekte in QKM
$area / 1000000

Spalten verketten und in eine neue Spalte schreiben
Spalte 1 Il Spalte 2

Felder liber Case Bedingungen andern
Case When SQL-Bedingungen when Wert oder Spalte End

Online-Datenquellen mit QGIS
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400 RLBV/RE © PP E R s Ogeeaa [l es PO L
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Layer = |
:
o) | Exkurs: Case-Bedingungen

@ Werte agregieren uber Case-Bedingungen in einem Schritt

Case
‘_'_:f-When "OK1234_T" IN (

then 'Siedlung’
When "OK1234_T "IN ( '4101 Ackerland’, ‘4102 Gruenland’, ‘4103 Gartenland’, ‘4107 Wald, Forst' )
then 'Land- und Forstwirtschaft'

i End

- CASE (Anweisung beginnt)

- When (Es folgt die erst Bedingungung)

e SQL-Bedingung wie Abfrageeditor

then (Es folgt der Wert oder der Inhalt einer Spalte oder eine Berechnung)
Ein Text- oder Zahlenwert, eine Spalte oder eine Berechnung

A When.... (weitere Bedingungen)

2 then....(Weitere Anweisungen)

END (Anweisung zu Ende)

. . UNIKASSEL Architekt
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Schritt 3: Bedingungen der Regel verfeinern

{ Layeroigenschafien - Pol 2]
Sl I Beschriftungen | T Felder | . Aillgemein | {4 metadaten | &+ Aktionen ‘ *IE & stil I » Beschriftungen | ™ Felder | “, Allgemein | (ID Metadaten | @Q’Aktionen | b-(ﬁ‘.-@rkn[]pf4<|>
[Regetoaserend ] .
Regelbasierend n Alte Darstellung n
Min. scale Max.scale
e — e Label |Ru|e | = |Max.sca|e |
Farbs andern Landnutzung NOT "landuse" ="
Transparenz andern
Ausgabesinheit andern i Eine Regel fur Kategorien prazisieren
Refine current rule Mafistabe zur Regel hinzufiigen
Kategroien zur Regei ninzufugen Spalte [Ianduse |v]
Bereiche zur Regel hinzufiigen
Symbol l . Andern l Farbverlauf [l | ||| |||| bunt2 |v]
Symbol [ wert | Beschriftiung S
L/ alotmerts  allotments
< . basin basin
. cemeteny cemeteny
commerzial commercial
. construction construction
. farm fam
farmland farmland -
farmyard fammyard =
L=
[Klass.iﬁzieren] [ Hinzufiigen ] [ Laschen l [AJIE léschen ] [ Yerbinden ] [Erweitert ']
l CK ] [ Cancel ]
.. .. ) Hinzuﬂ]genl l fi Eearbeitenl l:—‘. Entfernenl lAk‘tueIIe Regeln verfeinern 'l
Kategorisierte Symbolisierung
einer Regel definieren lStiIvorgaben wiederherstellen] l Als Vorgabe speichern ] ’ Stil laden... l l Stil speichern... ]
[ OK l ’ Cancel l l Apply ] [ Help l
. . UNIKASSEL &Architektur
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Schritt 4: Verfeinerte Regeln weiter bearbeiten

{¢ Layereigenschaften - Pol b

< st [ ’ Beschriftungen | ™ Felder | “, Allgemein | {D Metadaten | g Aktionen | vﬁ\rerknuﬂT

Regelasererd |7

Alte Darstellung

"landuse" = 'cemetery’
"landuse" = 'commercial'
. "landuse" = 'construction’
-l "anduse" = 'farm'
= . "landuse" = 'farmland'
- "landuse" = farmyard'
"landuse" = 'forest'

\‘. "landuse" ='grass’

"landuse" ='co
"landuse" = 'farm’
"landuse" = 'farmlan
"landuse" = "farmyard'
"landuse" = forest'
"landuse" ="grass’
"landuse" = 'greenfield'
"landuse" = 'meadow’

"landuse" ='greenfield'
[l "landuse" = 'meadow!'

Label |Rule |Min.scalu
B MNutzung NOT "landuse" = "
. "landuse" = 'allotments' "landuse" = "allotments'
"landuse" = 'basin' "lan

-l "anduse" = retail’ duse" = "retail'
«f stil l * Beschriftungen | " Felder | “, Allgemein | @ Metadaten | ﬂﬁ*hhbnen | "(FVerkniipﬂ.l‘l'
(Regeibosiorsnd 7
Label |Ru|e |I'u'1in.sca|e
-  MNutzung NOT "landuse" = "
Wohngebiet "landuse" = residential'
Jede Rege| kann einzeln beschriftet und N gewerbe ::Ianduse::=:commerc:ial'|OR "tags" LIKE '%agenerator'
. . " N Baustelle landuse" = 'construction
symbolisiert werden. Kategorien konnen \ Parkplatz "amenity” = 'parking’
aali . \~ T Friedhof "landuse" ='cemetery’
nachtraglich zusammengefasst werden: N | # Keingarten it e
z.B. Grunland: : Landwirtschaft "landuse" in ('farm', 'farmland', farmyard')
. . Griinland "landuse" in (‘meadow’ ' field !
Janduse” in (‘meadow’, ‘greenfield’, 'grass’) Tl wald aanduse in {meadow. ‘greenfield. grass’)
Als Grinland werden Objekte symbolisiert, die / y Regenrickhaltebecken 'landuse" = basin
in der Spalte ,landuse” Uber eines der gelisteten e landuse’ = retal
Attribute verfigen)
. . UNIKASSEL &Architektur
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E] Layer |
. Fertige Regelbasierte Darstellung des OSM-Polygonlayers
i
Q‘D -
b4
-
“< ¢ Layereigenschaften - Pol dl B
-
- : : =] 7 - I P are - I3 o T lii - .
‘.3‘ < Stil I |7 Beschriftungen | | Felder | %, Allgemein | " Metadaten | Qghkmnen | "QVerknupfungen | | * | Diagramme | L# | Uberlagern l Gebaude mit besonderer Bedeutung (Schulen etc.)
Regelbasierend |~] Eme e rden Uber eine Ahnlichkeitsabfrage definiert, die
sich auf den Begriff ,buildings” in der tags.Spalte und
Label |Rule [Mnsczie  Werte in der Spalte ,name” bezieht.
B Geb "tags" LIKE "%building%' r
%----EGebéude besonders "tags" LIKE "%building®' AND ("tags" LIKE '%aname%' OR "tags" LIKE 'Seschool®:' OR NOT "name" = ")
----- Gebaude normal "tags" LIKE “ebulding7e AND 'name"” = "
g phueung POT landuse = Einfache Kategorisierungen der
1 Wohngebiet "landuse" = 'residential' { . K
Xy gewerbe "Tanduse™="commercial' OR "tags" LIKE "%generator®' Spalte Ianduse, hier WOhngeblet
-~ Baustelle "landuse" = 'construction’ 1
ot -~ Parkplatz "amenity" = 'parking'
-+ Friedhof "landuse" = 'cemetery’
" - |fa Kleingarten "landuse" = "allotments’ . . .
- | andwirtschaft "anduse"in ('farm' ‘farmland' ‘farmyard') AUf“StUng mit der SQL'Funkt|On
'ﬁ -1 Griinland "landuse” in ('meadow', 'greenfield' . 'grass') I SIN“
- [l Wald "landuse" = forest - -
@ Regenrickhaltebecken "landuse" = 'basin' 1 hier: Grinland
. "landuse" = "retail’ "landuse" = "retail'
) B amnety "amenity” 1S NOT NULL
X E Feuerwehr "amenity" = 'fire_station’
Tankstelle "amenity" = 'fuel'
--[ ~ Kindergarten "amenity" = 'kindergarten’
33 . Schule "amenity" = "'schoal'
?" - [l Kirche "amenity" = 'place_of_warship' ] - - -
) gl Freizeit/ Sport "tags" LIKE "Sleisure®' Differenzierte Auflistung von
- «| Tennis "tags" LIKE "“%tennis®' A ¥ A i i
) ~[ sportplatz tage" LIKE aptch% Sportflachen ber Ahnlichkeitsabfragen
p': - @ Spielplatz "tags" LIKE "%playground®' (LlKE)
.
‘1 i | 0
) Hi.nzuﬂlg,enl ’ /| Bearbeltenl [E Entfernenl [Aktuel.be Regeln verfeinern 'l
l Stilvorgaben wiederherstellen l l Als Vorgabe speichern l [ Stil laden... l ’ Stil speichern... ]
’ 0K l l Cancel ] ’ Apply l l Help ]
. . UNIKASSEL &Arohitektur
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E] Layer [ "
—| Schritt 5: Mit Hilfe von Symbolebenen die vertikale Visualisierung der Objekte steuern
—
e In den ,,Layereigenschaften® auf die Schaltflache ,,Zeichenreihenfolge* klicken
-
..3: Da es im OSM-Datenmodell sich Uberschneidende Polygone gibt (Ein Gewésser im Park) und die Anzeigereihenfolge
manchmal nicht den Erwartungen entspricht
(Das Gewaésser liegt unter dem Park — verschwindet also unter der Parksignatur),
muss die vertikale Reihenfolge der visualisierten Regeln bzw. Kategorien festgelegt werden:
Die Regel ,Gewdésserdarstellung® ist oberhalb der Regel ,Parkdarstellung” zu visualisieren.
. 2]
&y st I | = Beschriftungen | :Felder | "Q Allgemein | OMEEdEtEH | @'Aktianen | “\Erh‘lﬁpﬁmgen | ;illDiagrammE | ;!LIUbErlagem l Je haher die Ziffer fl"'lr die einzelne Symbolebene,
[Reocbasens || |‘{5‘”""“*’E"E”] [ate parscura desto hoher die Prioritit:
o Beschiftng | Regl [ | & Symbolebenen HE . . . . . .
. —— » pryP— Das blaue Symbol fur ,Gewésser’ hat mit ,4“ eine
ﬁ i - %] Symbolebenen aktivieren
e iigﬁ gs EiEE%QLfd okt Sl g, i et e e hohere Prioritat als die ,,Gr[]nfléghen“ r_r;it dem Wert
) | e LT Layer0 Layer 1 ' "3 Deswegen werden die Gewasser uber den
.. losspal name = "Schioss Park’ . . . . .
P UG g ‘ Grunflachen angezeigt. Ansonsten liegen die
v Pakplatz tags Ia‘ -ae‘.:i; 3 . . . .
o D — Gewasser im Beispieldatensatz unter den
?" [ | Gem\.:r::iren ﬂagsILIKEI;‘, .- ORttaaj: H:E ...... |2 5 GrunﬂaChen!
L) Gewerbe tags LIKE*Tindustrial®” e __A Héhere Prioritat . - . g oun .
) g e e | 2 Es konnen auch genau definierte Prioritaten fur
po B amenty - knderatn O amerty -~ SR einzelne ,Symbollayer” eines Kategoriesymbols
P4 sondere G- tags LIKE "%building®’ AND NOT nam_ ; E . .
Y Y ] festgelegt werden, was fur eine gute Darstellung
OK Cancel Hell . . .
lmmwm © Kene - ] des StralRenlayers wichtig ist!
l verhalten [%] symbolebenen aktivieren [3€] riur erste passende Regel l
[ Stilvergaben wiederherstellen ] [ Als Vorgabe speichern ] [ Stil laden... ] [ Stil speichern... ]
OK ] [ Cancel ] [ Apply ] [ Help ]
: - UNIKASSEL /\—Architektur
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Schritt 5: Mit Hilfe von Symbolebenen die vertikale Visualisierung der Objekte steuern

In den ,,Layereigenschaften” auf die Schaltflache ,,Zeichenreihenfolge* klicken

+ Layereigenschaften - Pol

& Stil I | Beschriftungen | " Felder | “, Allgemein | ([D Metadaten | ﬂg‘hhk:-nen | l*‘}\r’erlmur.lfu.ngyerl. | [¥] Diagramme | [¥] Uberlagern l
I Layer 0 Layer 1 Layer 2
Regelbasierend ﬂ Alte Darstellung V — 0
Label |Ru|e |Min.sca|e .Gebaude AT . 5
B Geb "tags" LIKE "%building%'
.-l Geb3ude besonders "tags" LIKE '%building®' AND ("tags" LIKE '%aname®%' OR "tags" LIKE '%school®%' OR NOT "name" = ") B Gebsude normal B
[l Gebzude normal "tags" LIKE '%building%"' AND "name" ="
B Mutzung NOT "landuse" = " Nutzung 0
Wohngebiet "landuse" = 'residential'
gewerbe "landuse" = 'commercial' OR "tags" LIKE '%.generator%' Wohngebiet 1
Baustelle "landuse" = 'construction’
Parkplatz "amenity" ='parking' gewerbe 1
-+ Friedhof "landuse" = 'cemetery’ "
-l Kleingarten "landuse" = 'allotments’ 1
. Landwirtschaft "landuse" in ('farm', 'farmland', farmyard') Baustelle
Grunland "landuse" in (‘'meadow', 'greenfield', 'grass') 3
- Wald "landuse" = ‘forest' Rl
. Regenrickhaltebecken "landuse" = 'basin’' + e +-
. "landuse" = 'retail' "landuse" = 'retail' et L =
B~ amnety "amenity" |3 NOT NULL : i
E Feuerwehr "amenity" = 'fire_station' TR ! i
Tankstelle "amenity" = 'fuel' ;
; Kindergarten "amenity" = 'kindergarten’' pandaiiecal !
-l Schule "amenity" = 'school' -
. kd Kirche "amenity" = 'place_of_worship' Grinland L 2
BB Freizeit/ Sport "tags" LIKE '%leisure®'
- | Tennis "tags" LIKE '%atennis%' B wald 2 .
|| Sporplatz "tags" LIKE '%apitch%a’ -
- @| Spielplatz "tags" LIKE '%playground%' Regenriickhaltebecken L
| i | y oD I "landuse” = "retail ||
) Hinzuﬂlgen] l i Eearbeiten] [E Entfemen] lAktueI.Ie Regeln verfeinern '] Zeichenreihenfolge... amnety o
I l I ] I ] [ Feuerwehr [ [] @7
Stilvorgaben wiederherstellen Als Vorgabe speichern Stil laden... Stil speichern...
[l Tankstelle Wo s B 7
l 0K ] l Cancel ] l Apply ] l Help ]
[~ Kindergarten H: 7
oK ] l Cancel l l He
. . UNIKASSEL & Architektur
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Schritt 9: Mit Hilfe von Symbolebenen die vertikale Visualisierung der Objekte steuern

In den ,,Layereigenschaften” auf die Schaltflache ,,Zeichenreihenfolge* klicken

{; Layereigenschaften - Pol

< stil I |7 Beschriftungen | = Felder | ., allgemein | (D metadaten | 4

[Regeiasirend ]

Label
B ~ Geb

|Ru|e

Gebaude mit hdéherer Ziffer als
Flachennutzung: liegen immer oberhalb

—

"tags" LIKE '%building3g’
Tags' LIKE 'Sabuilding' AND ("tags
"tags" LIKE "Sabuilding%' AND "nan

-l Geb3ude besonders
Gebaude normal

B Mutzung NOT "landuse" = "

Wohngebiet "landuse" = 'residential'
gewerbe "landuse" ='commercial' OR "tags" |
Baustelle "landuse" = 'construction’
Parkplatz "amenity" = 'parking’

-+ Friedhof "landuse" = 'cemetery’

-l Kleingarten "landuse" = "allotments’
Landwirtschaft "landuse" in { 'farm' ., farmland' . 'farmy|
Grinland "landuse" in (meadow', 'greenfield", 'd

. Wald "landuse" = 'forest'

"landuse" = 'basin’'
"landuse" = "retail’
"amenity" IS NOT NULL
"amenity" = 'fire_station’
"amenity" = 'fuel
"amenity" = 'kindergaren’

z Regenriickhaltebecken
. "landuse" = 'retail'

El- amnety

E Feuemwehr

Tankstelle

[— Kindergarten

-l Schule "amenity" = 'school'

- [l Kirche -amenity" ='place_of_waorship'
=l Freizeit/ Sport "tag '%|eisura %!’

| «] Tennis "tags" LIKE "% by

~|_| Sportplatz "tags" LIKE '%apitch%'

- | @ Spielplatz "tags" LIKE "Saplayground?a’

4] e

® Hinzufﬁgenl ’ i Bearbeitenl IE Entfemen] lAktuelI.e Regeln verfeinern 'l

Stilvorgaben wiederherstellen l l Als Vorgabe speichern

{ Symbolebenen

Darstellungsreihenfolge der Symbollayer festlegen. Die Anzahl der Zellen legt fest in
welchem Darstellungsdurchlauf der Layer gezeichnet wird.
Layer 0 Layer 1 Layer 2
Geb 0
M Gebzude besonders Hs
I Gebsude normal I
Nutzung 0
Wohngebiet 1
gewerbe 1
Baustelle 1
Parkplatz 3
+ - Friedhof 1 il
i:! Kleingarten 1 il 2
Landwirtschaft 1
Griinland 1 2
B wald [ 3
Regenriickhaltebecken 1
."banduse" = 'retail' o
amnety 0
[T Feuerwehr [ ] 07
& Tankstelle Ho s B
[~ Kindergarten i 7
[ ox ][ conca | [ +d
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Layer | = L
Exkurs: Symbologie fur Regeln erstellen
Stile speichern
Mit Doppelklick auf
das Symbol zur Symbolisierung andern . .
Symbolauswahl Vorgefe__rtlgte Stile
wahlen
Regeleig il .3
s Sfil l Beschriftungen ‘ = Felder | "’% Allgemein | {:ﬂ) Metadaten ‘ ..\}'é} Aktionen u("] Verknipfungen ‘ | I{l P s::hriFthgl ’I / \ l
Filte EE
M [Symbolebenen] [Alte Darstellung] I "[ II I/ H l\ — l
Begchreibung [ I / \ ]
|Bgschiftung | Regel | Min Mafstab | Max Mabstab | P4 MaBstabsbereich [ \
n # Hinzufi
t§ Stadi tags LIKE “:athlatios:
- SpEiIeIEII;tz t:g: LIKE ?-';pla}'g:zznd’.-'; ‘. Bearbeiten Symbal I / \

Sonstige Geb_ tags LIKE “tbuilding®’ AMD name =

. Schlosspark  name = Schloss Park Einheit
o Platz tags LIKE “thighway (== Entfernen
Y Pakplatz  tags LIKE “iparking?: Transparenz %
Ortschaft allg - landuse = residential
Landwirtschaft tags LIKE “imeadow™ ORtags LIKE Préazisieren Farbe

Grinflachen  tags LIKE “eisure®’ OR tags LIKE
Gewasser tags ILIKE “iwaters ORtags LIKE =

Gewerbe tags LIKE “tindustral £ Hishere Prioritat -, Andern...

+* Friedhof tags LIKE “tFiedhof L

= Als 5til speichern

Freizeit und S5 landuse = recreation_ground” OR tags . . :
’ o . ! ) Gespeicherte Stile Stilmanager. ..
Bildungseinrz_ amenity = kindergarten OF amenity = 7 Niedrigere Prioritat

H Resondems G tans | IKE Shuidina A0 NOT nam
4

:E L
=
® Keine {_} Filter ) MabBstab

[ | | (277771 B I iEEEE

:

Regelgruppierung
l Verhalten [%] symbolebenen aktivieren [ rur erste passende Regel ]
l 0K ] [ Cancel l
[ Stilvargaben wiederherstellen ] [ Als Vorgabe speichern ] [ Stil laden. .. ] [ Stil speichern... ]
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Layer [

Exkurs: Symbologie fur Regeln erstellen

Eigenschaften des
Symbols bearbeiten

dem Stilmanager
auswahlen

Fertiges Symbol aus /

4 Regeleigenschaften

21 %]

Beschriftung [ wald

Filter [ Tanduse” = 'forest’

Beschreibung [

- [_] MaBstabsbereich

]
[
]

Min, Malistab | 11 1000

= Max. Mafistab [1: 1000

)

- 3] symbal

Einheit

Transparenz 0%

Farbe

[ Millmeter Rd
G
[ @ indern l

1

Gespeicherte Stile

14
[

¢ -
-
e &

Symbol zum
Stilkatalog hinzufiigen
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2 U _RRELPPY LEEWe T TEH2ONS @'; el ed ey elic. 0 L gt

©L)- B NI N =0 e ¥w EK - - Saadde @5 @0 [(dldldledl ]
=) |

| Exkurs: Symbologle fur Regeln erstellen: Elgenschaften des Symbols bearbelten

< Komplexe Symbole lassen Polygonsymbol aus zwei Symbollayern
| sich aus mehreren Einzel- Eigenschaften: Einfache Fullung
-
» | symbolen (Symbollayern) : -
L L E) 7| X
2 | aufbauen! Dabei kénnen + Symboleigenschaften i Symbollayertyp:
“ | sowohl einfache FQIIungen Symbollayer Symbollayertyp [Enfache Fiillung |",]’/ Funf verschiedene
erwendat worden. e e Fultypen sind wahioar

Punktrmusterfiillung
// B Eirfache Fillung Farbe S5 Fiillun
Xy Liste der

Fiillstl Rand: Liniendekaoration
Symbollayer Rand: Markierungslinie
_— Rand: Einfache Linie
Randfarbe - J Darstellungs-Eigenschaften

& | — \FT\/ fiir ,,Einfache Fiillung*
D) Sh){mbc;!_layer Randsd [ — bearbeiten
o Inzutugen Randbreite | 0,26000 =
\‘\M — X-,Y-Versatz lo,oooo0 |5 |oo0000 |
= ®ll=)2]al[<]
é‘_\ Symbollayer / Symbalvoransicht
) entfernen
:': 13 a3
L Vertikale Anordnung
c der Symbollayer
bearbeiten
Resultierendes /
Symbol 0K ][ Cancel l
. . UNIKASSEL NArchitektur
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SRENe ?g;gﬁo--mﬁpﬁ R o R 15%@35 @\_\:; R eciNONG! L
OL 2B s "“dhhdRNo X =B g = "B - Saa@dd 18, @0 [(didldledlldl] E
@0 [
@ Exkurs Symbologle fur Regeln erstellen: Eigenschaften des Symbols bearbelten
< Polygonsymbol aus zwei Symbollayern
@ Eigenschaften: SVG-Fillung
-
‘.3: i Symboleigenschaften K E
o Symbollayer Symballayertyp SWG-Fiillung | -
Liste der ] | * SVGFiilung ~Symbollayereigenschaften fﬁ?i;‘;?:é%ﬂﬂg | | Art der Flllung auswahlen
: Punktriusterfiillun
Symbollayer B Gifache Filung Texturbreite SlGtilng |
Intache Fuliung
X0 Drehung Rand: Liniendekoration
Rand: Markierungslinie
Farbe Rand: Einfache Linie
A Rand bearbeiten
Randfarbe ’ Andern l
5 [ 55
D) Randbreite 0,00000 =,
P Symbollayer /\ / SVG-Grafik aus
‘ hinzufiigen e Umrandung | Andern / der Liste wahlen.
3 | - | Fa | | 7 /| (Unter Einstellung > Optionen 3
) . :/j - SVG lassen sich Ordner mit
. e "l - SVG-Grafiken hinzufiigen)
3 Symbollayer i <
e entfernen E
// [G:j'E_kartengestaIangftexttl.lrenfsvgsﬂ 10_laubbaum_3bi,sva ] [ /l’// SVG-Datei direkt wahlen
Resultierendes Vertikale Anordnung
Symbol der Symbollayer ok || cancel |
bearbeiten
. . UNIKASSEL NArchitektur
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@6 |
@ Exkurs Symbologle fur Regeln erstellen: Eigenschaften des Symbols bearbelten
< Polygonsymbol aus zwei Symbollayern
@ Eigenschaften: Linienmusterfullung
-
Ex} 4} Symboleigenschaften il
Symballayer Symboll Linienmuster fii hd
= na?erm. E— mf.ﬁ"‘"‘" =] Art der Fiillung auswihlen
Liste der /\\\l Zertriete Filung —Symbollayereigenschaften -
Symbo"ayer Punktmusterfillung
I" Linienmusterfillung SVGFiillung
Winkel Einfan:hn_a Eullung _
- —
Entfernung f"f!ﬂf: Einfache Linie -
© Linienbreite [ 1,00000 =
Ol|s
ymbollayer
& hinzufligen /\ a [_] [g] [\;-] Versatz | 0,00000 =
. Linienmuster bearbeiten
’qa mbalv/wﬁs:mt
e Farbe ’ Andern ]
= )
) Symbollayer / i
n entfernen Umrandung ’ Andern 1 - Rand bearbeiten
//
. / oK Cancel
Resultierendes Vertikale Anordnung ’ ] ’ ]
Symbol der Symbollayer
bearbeiten
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OR-2BEE " ABDE L =R e = "B - Sa@d 1@8.5 S0 [dléldld10] L ' e
fo Exkurs: SVG-Grafiken erstellen und fur QGIS zur verfugung stellen
.. SVG-Grafiken lassen sich in vielen Vektorgrafik-Programmen erzeugen.

e Z.B. beherrschen Inkscape und lllustrator den SVG-Export.
<} Die Firefox-Erweiterung SVG-Edit bietet einenn einfachen SVG-Editor

Einfach ist auch der Export von SVG aus dem OpenOffice-Prasentationsmodul ,, Impress®.

Impress starten, und Seitengrof3e 5 X 5 cm auswahlen.
- Mit den Zeichenwerkzeugen eine einfache Grafik erzeugen
Uber Datei > Exportieren > SVG eine SVG-Grafik erzeugen

®
)
g SVG-Ordner in QGIS anmelden
%) Die eigenen SVG-Grafiken in einem oder mehreren thematischen Ordnern speichern.
N Uber Einstellungen > Optionen > Darstellung u. SVG > SVG-Pfade

lassen sich die Grafiken in den ausgewahlten Ordner der SVG-Auswahl in QGIS hinzuflugen
S
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B - | - Visualisierung Linien-Shapefile

—

»
v

Die OSM-Shapefiles lassen sich kategorisiert darstellen:

N
¥

Beim Linienlayer ist die Attributspalte ,,Highway* maRgeblich

Visualisierung in ,neuer Darstellung”
Layer > Eigenschaften > Stil (Neue Darstellung): kategorisiert im Pulldownmen(i auswahlen

Spalte: Highway ki
erhet [l |<]

Brelte =
it Layereigenschaften - Linien_neu 21Xl Transparenz % [——

-y

[ Symbolebenen:
cepecere S Reihenfolge der Symbollayer
o [Tl | — —%— — festlegen!

®
E%D) i siehe Nachste Seite

ertia
= path path 2
) |assified {assified y - -
:ervi:a :grcvice ’ ) = e S b I I h i f"
k") — cycleway  cycleway = = ym O a ye r I n Z u u g e n
qa - footway fDUl‘.\'a‘,f {} Symboleigenschaften '
$ S T — und anordnen!

?{' - track track
Y

Symbollayereigenschaften H ie r Stra Be a u S Wei Ber
1 3 = Eirfache Linie _M Andern I d h L' . '
L~
po ! [ = und schwarzer Linie!
o> Versatz | 0,00 (5]
[Ida Esifizieren ] [ Hinzufiigen I [ Lischen I [ Alle léschen I [ Verbinden ] [ Erweitert '] D E] suft [—Durmgemgena L ‘v]
Symbolvoransicht [] Benutzerdefinierte Strichlierung verwenden
[Sﬁ\vorg tben wwederharshe\lan] [ Als Vorgabe speichern ] [ stil laden.., ] [ stil speichern. .. ] Andem
l oK ] [ Cancel ] [ Apply ] [ Help I —— Verbindungsstil n
Fr—n
Klassifizieren! |
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A4 - RRELOECRE L REDQ s Jmseaa [Pl es PO L 0y
©Ll:2 8@ s""dRNaE N =R g vz "FE - -Saadeée 1@ S@O [dleldld 107 "
L= = | -n - - " = v
= Symbolebenen verwenden (Schaltflache ,,Symbolebenen* im Darstellungsdialog!)
. C 2
w
XY Mit
Symbolebenen!
ﬁ {} Symbolebenen HE
% o h ne Er:;:T:::s:::z\(::i:r:rnSymbo\layEr festlegen. Die Anzehl der
3 I ‘Z“?rllden legt festin welchem Darstellungsdurchlauf der Layer gezeichnet
Symbolebenen! — — —
ér\ =2 5
'\.3 -D‘ 4 g
r-.
“*| Mit Hilfe von Symbolebenen lassen sich grafisch A o e ]
korrekte StraBendarstellungen, auch bei aus
mehreren Symbollayern visualisierten Linien-
Shapes erstellen. Es gibt keine Unterbrechungen Di¢ Symbollayer mit dem hoheren Ziffernwert, liegen Uber den
an Segmentgrenzen und flieRende Anschliisse! Symbollayern mit dem niedrigeren Ziffernwert.

omit liegen die schwarzen Autobahnrander immer unterhalb!
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Layer
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st
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[%] Diesen Layer beschriften

Feld mit Beschriftungen | VERZEICHMI n

LRE®e 0 Tm@emn [@aaucas
LWBDE =D e v "B - Sads @SS (dialda2l]
& |

] Layerbeschriftungseinstellungen

StraRenbeschriftung

Intelligent*

YeLSHONS

—
e

e
—
—_—

AL

—Platzierung |
I
[%¢] iiber Linie 9{% |
) paralel '
[ aufLinie Heinemannstralte
@ gebogen |:| unter Linie
Orientierung @ Karte () Linie Re
) herizantal =
Beschriftungsabstand mm
Y st —Pricritat
Schriftart Arial, 12 pt E Miedrig ‘ﬁ@ﬁ' Hoch
' Farbe
E —Malistabsabhdngige Darstellung —
Puffer (%] Grafie | 1,00 mm =) Farbe Friedrich-Ebert-Strae
3 S DT 51T R —
- =]
O .. Lromipsum
) Geysostratie

[] alle Teile eines mehrteiligen Objekts beschriften

[ Anschliefienden Linien verbinden, um doppelte Beschriftungen zu vermeiden

Objekte nicht beschriften, wenn kiirzer als 0,00 mm

S

[ ohiekte sind kein Hindernis fiir Beschriftungen

[Eesdvifb_lngseinstellungen l

[ ox || Abbrechen |

Goethestralke

Herkulesstralke

Layer > Beschriftung

enstralle

4+

Breitscheidstrape

QG%@
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OpenStreetmap-Daten visualisieren
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G'rundlegende Einstellungen im intelligenten labeling
Die Basiseinstellungen im intelligente Labelling lassen sich im Reiter
Beschriftungseinstellungen festlegen
Beschriftung _
aktivieren ¥ Layerbeschriftungseinstellungen HEHE

| X Diesen Layer beschriften Feld mit Beschriftungen \J

Lrom lpsum Attributspalte fur
pespe Labeling auswahlen
Beschriftungseinstellungen [ , Erweitert ‘ Datendefinierte Einstellungen ‘

I

Einstellungen zur
Schriftformatierung

e~ —Textsti

schiftart Arial, 10pt [ ... | Farbe [ rode (10,0000 F5] [1n Punkten [~]

= (%] Puffer

\l

Schrift wird zur
besseren Sichtbarkeit
weiB oder farbig
hinterlegt

et (1o [2] rrse [

’_D MaBstabsabhingiae Darstellung

\|

T\

[Mirirnum 1 F= [masimum 10000000

Hier kann ein
MaRstabsbereich festgelegt
werden, in welchem die [ oc J[ cance | [ appy
Beschriftung angezeigt wird

. . UNIKASSEL Architekt
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. o Automatische Platzierung
Die automatische Platzierung im intelligente Labelling lasst sich im Reiter
. Erweitert > Platzierung einstellen
Beschriftung 4 Layerbeschriftunaseinstell =
ktivieren ! aye SC ungseinsicliungen h
a | [%] Diesen Layer beschriften Feld mit Beschriftungen \I %
o Lrom Ipsum Attributspalte fur
P Labeling aliswiahlen
Reiter: | ___I;__B&edaﬁﬁhmgsm ‘ , Erweitert l Datendefinierte Einstellungen ‘
iterte K
erwe_l e Platzierung @ 'SP 6""@
Platzierung N o ©
) parallel [ aufLiie +
B hrift | | ® gebogen [ unter Linie
eschri ung i o Orientierung ‘@ Karte { Linie
entlang gebogener Beschriftungsabstand | 0,5000 I%] [In mm |v]
Linien moglich o
—Prioritat '640 _
Miedrig 0 Hach . o’%,,
I 1 I ‘%:’
(A
—Optionen
[] alle Teile mehrteiliger Objekte beschriften
N icht jeder I —— [ Ansmlié.ﬁende Lini-en verbinden, um doppelte Beschriftungen zu wermeiden
Li n ie nabSCh n itt O M.ehrzeﬂlge EESd"II’I.Fb.Ir'Ig-EI"I
. . [ Richtungssymbol hinzufigen
wi rd beSCh rlftet Objekte nicht beschriften, wenn kiirzer als 0,00 mm I%]
[] objekte sind kein Hindernis fiir Beschriftungen [Besmrifb.lngseinstellungen ] E
’ CK ] [ Cancel ] [ Apply ]
. . UNIKASSEL Architektur
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£ ) Einzelne Themen aus dem Polygonlayer extrahieren

- Gebaude extrahieren
Die schon bei der ,regelbasierten Darstellung” verwendeten Attributabfragen lassen sich nutzen, um
einzelne thematische Ebenen, wie z.B. die Gebaude als eigene Layer zu speichern!
Uber
Layer > Attributtabelle 6ffnen > erweiterte Suche
gelangt man zum Abfrageeditor

>
=

®

g Auswahl tiber Ahnlichkeitssuche in der Spalte ,,tags“ moglich
Gebaude lassen sich z.B. Uber die tags ,building” und ,addr” finden
%)

N

) Syntax:

» tags LIKE '%addr%' OR tags LIKE '"%building%'

N I K L &Architektur
ERSITAT /\_Stadtp'anung
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Layer mit eindeutigen Flachenzuordnungen erzeugen

Im OSM-Modell Giberschneiden sich Flachenzuordnungen ahnlich wie im ATKIS-DLM
Beispiel:
Ein Gebaudepolygon (,building = Yes®) liegt Uber einem Polygon mit der Zuweisung ,/eisure=Park” und
dies wiederum uber einem Polygon mit der Zuweisung "landuse"="residential" (Wohngebiet).
Um eine eindeutige Flachenzuordnung zu erreichen, weil man z.B. die nicht von Gebauden Uberbaute
Flache eines Wohngebiets ermitteln mochte, kann die vorher ausgewahlten Teilflachen (Gebaude) aus
dem Gebiet (Wohngebiet) ausstanzen.

g0 o0

Layer gegeneinander ausstanzen A
Vektor > Geoverarbeitungswerkzeuge > Differenz IEI
z.B. Gebaude aus einem anderen Layer ausstanzen

Dort, wo vorher die Gebaude waren, sind anschlieRend Locher

reevoe

b’
”

L]

Eingabevektorlayer:  Der Layer, in welchen die Locher gestanzt werden sollen.
Differenzlayer: Die Objekte dieses Layer stanzen die Locher

. . UNIKASSEL Architekt
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A Layer mit eindeutigen Flachenzuordnungen erzeugen
* Layer zusammenfuhren
"_3 Mochte man aus den einzelnen zugeschnittenen Layern wieder einen Gesamtlayer erstellen, der dann
keine sich uberschneidenden Polygone enthalt, so verwendet man das Werkzeug:
Vektor > Datenmanagementwerkzeuge > Shapedateien zusammenfiihren ‘ﬁ
Es lassen sich samtliche Shapes eines Ordners oder einzeln ausgewahlte Shapes,
v zu einem neuen Shape zusammenfuhren.
g Mit Hilfe eines solchen Shapes lassen sich dann beipielsweise prazise Flachenbilanzierungen durchfuhren
3y
A
)
n
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SRTM-Daten finden

Im Rahmen des Shuttle Radar Topography Mission (SRTM) erfasste Hohendaten mit einer Auflosung von 100 m.

Download:
http://netgis.geo.uw.edu.pl/srtm/Europe/ oder
http://dds.cr.usgs.gov/srtm/version2_1/SRTM3/Eurasia/

Die Daten liegen als gezipte HGT-Daten vor und kdnnen nach dem entpacken uber
Layer > Rasterlayer hinzufligen direkt ins QGIS geladen werden.
Unter Layer > Eigenschaften im Ausklappment ,Kontrastverbesserung“,Strecken auf MinMax)
Auch GRASS kann die Daten direkt verarbeiten.
Die Daten liegen im geographischen Koordinatensystem WGS 84 vor

Die Bezeichnung der Dateien ergibt sich aus den geographischen Koordinaten

N51E008.hgt.zip bedeutet
Die untere linke Ecke des Bildausschnitts (der untere linke Pixel!) liegt auf 51° Nord geographische Breite und 8°
Ost (East) geographische Lange.
Die Ausdehnung der einzelnen Kacheln betragt in jede Richtung ein Bogengrad.

Mit Hilfe der GDAL-Tools (Menu Raster) lassen sich die Daten ins Geotiff-Format konvertieren,
zusammenschweil3en und in ein metrisches Koordinatensystem (GK3, ETRS 89) umprojizieren.
Siehe Folien 9 (Luftbilder konvertieren)

Auf den nachsten Seiten: Folien zur Visualisierung von Rasterdaten!

. . UNIKASSEL Architektur
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Unter Layer > Eigenschaften im Ausklappmenii ,,Kontrastverbesserung“,,Strecken auf MinMax)

Einfache Graustufendarstellung

.chaften - Interpolation

k| —Anzeigen als

Farbabbildung umkehren, dann
reprasentieren dunkle Farben
hohere Bereiche

® Einzelner Graukanal (O DreiKanalFarben 3] Farbabbildung invertieren
Farbabblld u ng ~Einkanaleigenschaften
GraUSthen I rauer Kanal [Kanal 1 v

Farbabbildung [Grausmen

"+ Benutzer min/max-Werte

(" Standardabweichung verwenden

Min (185677 | Max [614.586

e

Beachte: Minimum Maximum Werte sind Annahmen, Benutzerdefiniert oder aus dem Bereich Berechnet

~Min/Max-Werte des Kanals laden Kontrastverbesserung
) Schétzen (schneller) Aktuel [Sh'ecke auf MinMax i v]
" Genau (Jangsamer)
i A Voreinste] Strecke auf MinMax
E  Aktuelle Ausdehnung Laden

Etil wiederherstelen ] [ Als Vorgabe s}ehﬁrn /H

Stil laden...

] [ Stl speichern... ]

o) (s | o ) [ ]

Kontrastspreizung aktivieren,
ansonsten sind keine Strukturen
zu erkennen!
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SRTM-Daten visualisieren
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=
" Farbreduzierte (indizierte) Rasterdaten (Ein-Kanal = bis zu 256 Farben)
N Dies trifft auf die SRTM-Daten zu!

Wir auch als Darstellung mit indizierten Farben bezeichnet. Die Farben werden nicht
direkt, sondern als Verweise auf eine Farbtabelle (Index) gespeichert.

Dies fuhrt bei wenigen Farben zu geringen Dateigrof3en

o 0olo|1[2]3 0 -
ol1]2]3]2

1=

1|2(3]|2]1 ) -

2|3[2]1]o0 s -
3|2|1]|0]|o0

Ein-Kanal-Rasterdaten (z.b 255 Farben / Graustufen) konnen in
Graustufen oder als klassifizierte Farbkarte dargestellt werden

NOXRBRDOR L D

Die Darstellungsfarbe jedes Farbwertes kann individuell gewanhlt
und individuell transparent gestellt werden.

Thematische Darstellung von Rasterdaten ist moglich
(Hohendaten, Topographische Karten etc.)
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SRTM-Daten visualisieren
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Layer [

Darstellung in Graustufen oder als Farbkarte

Einstellungen unter Layereigenschaften > Darstellung

Grundsatzlich lassen sich die Pixelwerte
indizierter Rasterdaten als durchgehende

Graustufenabfolge oder als Abfolge
individuelle auswahlbarer Farbwerte
(Farbkarte) darstellen.

Einstellung zur Kontrastverbesserung
von Graustufenbildern.
Wichtig bei Interpolierte Hohenrastern

L

[£]

Transparenz

Farbkare

&@

Algemsin

—Aanzeigen als

[} Layereigenschaften - 26 v4/722col

‘@ Einzelner Graukanal {3 Dreikanal-Farken

[ Farbabbildung invertieren

—Einkanaleigenschaften

Grauer Kanal [Kanal 1

Farbabbildung | Farbkarte

seudofarben
Aunzsefiippt
Farbkar

Einstellung der Farbabbildung

{7y Benutzer min/max-Werte

{7} Standardabweichung verwenden

Beachte: Minimum Maximum Werte sind Annahmen, Benutzerdefiniert oder aus dem Bereich Berechnet

—

Metadaten E

{» Genau (langsamer)

{7 Aktuelle Ausdehnung Laden

Voreinstellung Stredke auf MinMax

—Min/Max-Werte des Kanals laden —— Kontrastverbesserung
" Schatzen (schneller) Aktuel [Strecke auf MinMax | V]

[ ‘orgabestil wiederherstellen

l [ Als iorgabe speichern l [ Stil laden... l [

Stil speichern... l

[ oK ][ Cancel ][ Apply

J

Help l
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E4 - - Darstellung als Farbkarte

o~

Nachdem Sie unter Layer > Eigenschaften > Darstellung > Farbabbildung

| »Farbkarte® gewahlt haben, konnen Sie in der Rubrik ,,Farbkarte® verschiedene Einstellungen vornehmen.

Beispiel: Eine Topographische Karte mit insgesamt 8 verschiedenen Farbwerten (0 - 7)

-y

Laden und speichern von
Farbtabellen als *.txt.

4} Layereigenschaften - 26_v4722col

Plxelwert (bel 8 Werten 0 - 7) [a] ~Farbabhildung

Es ist auch moglich,

4| So lassen sich Darstellungs-

bei vielen Werten eine interpolierte % rertntErRaRen rer 7] vorschriften einfach
Darste"ung Umzusetzen. Darstellung [Entrag hII"IZL.Iﬁ.IgEI"Il [Entrag Ioschen] [ Sortieren ] m . E] . 1“--".- Ubertragen.
Weiterhin ist das Loschen ~| 7= !Fm TBeschiong (siehe nachste Seite)
einzelner Werte mogI|Ch ?gggggg ...............
- 2.000000
- 3.000000
- 4000000 B
® L Farben der einzelnen
) o & Werte. Mit einem Doppelklick
Farbkarte = -
) et auf die Farbbalken, lassen
C&{ s sich die Farben beliebig
- N andern!
& Allgemein - 15.000000
;r't —MNeue Farbabbildung generieren
"‘3 @ Eintragsanzahl [ Kiassifikationsmodus G|EId"IES Intervall M NaCh Einem DOppElkliCk
pe Metadaten 4 hinter eine Farbe, lasst sich

ein Text einfugen. Per
Screenshot konnen Sie aus
Farbbalken und Beschriftung
"1 eine Rasterlegende fiir
T das Karten-Layout erzeugen!

Vorgabestil wiederherstellen l [ Als Vorgabe speichern l [ stil laden... l [ Stil speichern... l
l

[ o || cancel || ooy ][ Help
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SRTM-Daten visualisieren
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Sicherung der Darstellung in einer Textdatei
Uber ,,Farbabbildung in Datei speichern“, lassen sich die
Darstellungsvorschriften als Textdatei speichern
(siehe vorherige Seite)
Wert R G B Be schriftung
0 0 0 0 255 Color entry 1
1 255 255 255 255 Color entry 2 /
2 191 242 128 255 Color entry 3 ;
3 204 102 102 255  Color entry 4 Farbtabelle im Textformat
4 191 255 255 255 Color entry 5
5 0 204 0 255 Color entry 6
6 0 128 255 255 Color entry 7
7 255 179 0 255 Color entry 8
Wert Farbe Beschriftung

T
SRR o,
ML
SRS
Py P
e UM NS

Color entry 1
Color entry £
Colar entry 3

I Color entry

4
Color entry 5
b
il

Colar entry
Color entry 7

Color entry &

/J

Resultierende Darstellung

Die Werte fur Rot, Grun
und Blau werden in
ublicherweise als
Zahlenwerte zwischen 0
und 255 gespeichert.
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- ol Klassifizierte Farbkarte in QGIS

::: 4} Layereigenschafien - Interpolation HE
4i. z ~Farbabbildung
& - - . « Farbinterpolation
- Farbabbildung erscheint nach —
- - gn . . - Ghos intrag hinzufiigen intrag lsschen ortieren nal 1 [+ |
.|| Kilassifikation immer in rot-blau-Abstufung. (oo remsion) Bt e | E]
b . - Farbe Beschriftun;
) Anderung manuell moglich. | [E - i
Es konnen keine Farbverlaufe vorab e
ausgewahlt werden. TM
. . ///T,/Z Farbkarte
Reiter ,,Farbkarte‘ - Hier erreichen Sie i
diesen Dialog! % =
XY Allgemein
e Anzahl der Klassen angeben ~Neue Farbabbildung generieren
- mit Schaltflache ,Klassifzieren*“ | | T s (5 T3 Kessotonsmodus [Gdesintonal_[7] [ Kosaiorn |
Farbkarte generieren e
ﬁ l Vorgabestil wiederherstellen H Als Vorgabe speichern H Stil laden... H Stil speichern. .. ]
| Kiassen renzen, Farbe und Beschriftun i
f

- . - - . rbinterpolation Diskret -
lassen sich manuell indern. Mit einem ~ e
S| Doppelklick auf die Werte, lassen sich die [wog ot [Eonag ot s | il )
& Klassengrenzen bearbeiten. Uber einen D et 'B"“""ﬁ

) Doppelklick auf die Farbbalken kommen
Sie in den Dialog zum Farben einstellen.

£ ]
P,
o>
Farbkarte
Allgemein

—Neue Farbabbildung generierer

Metadaten @ Eintragsanzahl [2 =] Massifiationsmodus~ [@iciches Intervall | = Kiassifideren

[ Vorgabestil wiederherstelen | | Als vorgabe speichern | | Sti laden. . || suspechem.. |

N IK L &Architektur
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Klassifizierte Farbkarten in QGIS

v
—

Klassifzierte Farbkarte in QGIS mit 1-Band Raster Colour-Table Erweiterung darstellen

Python-Erweiterung herunterladen
Rasterlayer im Inhaltsverzeichnis auswahlen und Erweiterung
uber Erweiterungen > Raster Colours >1-Band Raster Colour-Table Erweiterung V1.X starten

Sie konnen anschlielend aus vielen verschiedenen Farbverlaufen auswahlen

Darzustellendes Raster

Hier lassen sich unterschiedliche
Farbverlaufe fiir die klassifizierte
Darstellung der Farbkarte auswahlen

Wtﬁ

Klassifikationsmethode
auswahlen
(statistische Verfahren)

4} 1-band raster colour table

Textdatei in welcher die Farbtabelle gespeichert wird.
Farbtabelle lasst sich im Dialog Farbkarte laden

Input raster file ||nterp0| 1.asc

Output colour table [2_Kumpaktseminar'welkturdatenanalyse_20 10%thoehen’interpol1_302_elev kﬁd-full_EQ.txt ]

[ 302_elev_legend-full

["] Reverse colours

[~ [oEM [topa] -
.

Invert palette [ |

Use this plugin to create a
colour table for the select

1-band raster file.

Colouring method

- [ Equal area distribution (histogram equalization)

| TS

Band ¥ size: 1600

Band ¥ size: 1300

Total number of paints: 2830000

Mumber of points used in histogram: 63733

Minimum data value: 185,000

Maximum data value: 614,000

i

[ About l [ Help ]
< [ Close l [ Cancel ]
To apply a colour table when dosing, select it from the dropdown list beldw and dick the 'Close’ button

interpol1_302_elev_legend-full_EQ. txt

-]

Erstelite Farbtabelle auswahlen,
nach der das Raster dargestellt wird.

Farbtabelle in Textdatei schreiben
(siehe oben)
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Transparenz fur einzelne Farben einstellen

Unter Layer > Eigenschaften > Transparenz konnen Sie die Transparenz eines

Rasterlayers gobal oder fir jeden Pixelwert einzeln einstellen

In diesem Beispiel sind in der TK25 samtliche Farbwerte aul3er 3 (braun), 4 (hellblau) und 6 (dunkelblau)
zu 100 % transparent gestellt worden, so dass nur Gewasser und Hohenlinien angezeigt werden!

L

4 Layereigenschaften - 26_v4422col

B —Globale Transparenz

Einstellung der
globalen Transparenz

(’ET

Darstellung

O

Keine

0%

voll

|

Kein-Datum-Wert

[

[ Kein-Datum-Wert zuriicksetzen

Transparenzkanal
Transparente Pixelliste

—Benutzerdefinierte Transparenzeinstellung

[ icht gesetzt

Indizierter Wert

Farbwerte, welche
transparent dargestellt
werden sollen.

Sie konnen die
Werte manuell
eintragen oder aus
der Kartenansicht
abgreifen.

Farbkarte

Allgemein

Metadaten

—

0.00
1.00

5.00

:
200
4
5]

7.00

8.00

6]
1.DD

100.00
100.00
100.00
100.00
100.00
100.00

100.00

J Hier kann manuell
ein Pixelwert eingetragen

i werden.

Prozentuale Transparenz
der eingetragenen
Pixelwerte

Zeile zur Eintragung
eines weiteren Pixelwertes

@[]

:

[ Viorgabestil wiederherstellen l [ Als Vorgabe speichern ] [ Stil laden... l [ Stil speichern. ..
l OK l [ Cancel ] [ Apply l [ Help
L2 o T N NN

hinzufiigen

| Farbwert aus Kartenansicht
abgreifen

~

Zeile mit Pixelwert loschen

Online-Datenquellen mit QGIS
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Umgang mit Hohendaten i

A4 - RRBRL @ PP E R R s Ogeeaa [l es PO L =
CR-“BWie" " hRa =D w  » "B -Sa@e J@.. 3@ G0 F301 K-
E] Layer = |
~ Schattenrelief (Hillshade) erzeugen

& Ein Schattenrelief stellt die Hohenformen der Landschaft plastisch dar. Hangneigungen
* werden aus dem Hohenraster errechnet und uber Schattierungseffekte visualisiert
2 | Schattenreliefs lassen sich transparent Uber andere Karten legen, um Schummerungseffekte zu erreichen.
Die Darstellung kann Gberhoht werden, um das Relief deutlicher abzubilden.
Die virtuelle Sonnenhdhe und der virtuelle Sonnenstand sind einstellbar.

Ausgangsdatei ist jeweils das vorher erstellte interpolierte Hohenraster!

>
-

g @ Vorgehensweise unter ArcGis
ArcToolbox >3D-Analyst (SpatialAnalyst) > Surface > Hillshade
s| Deutsch: ArcToolbox >3D-Analyst (SpatialAnalyst) >Rasteroberflache > Schummerung
A
3 y) Vorgehensweise unter QGIS
@ T2
AV Raster > Analyse> DHM: Modus = Schummerung oder

Erweiterungen > GRASS > GRASS-Werkzeu. > Raster > Raumliche Analysen>Gelandeanalyse>r.shaded.relief
Oder: WXPython-Grass: Raster >Reliefanalyse >Reliefschattierungen (r.shaded.relief)

NIKASSEL &Architektur
ERSITAT /\_Stadtp'anung

Landschaftsplanung
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SRTM-Daten visualisieren i

444 RRKELPLCPEF R WQ e OESoR& Bl ada PO

©OL 2B " " RN X =R e vz *"BFN - Saads 18, @0 @?j{:}ﬁmﬁ - <

- o Schummerungskarte aus Schattenrellef erzeugen

e a1

|

ol
=

UXBRVOR ) O

[
e

Schattenrelief mit 60% Transparenz iber kIaSS|f|Z|ert

Schattenrelief dargestellten interpolierten Hohenraster
= . UNIKASSEL Architekt
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Umgang mit Hohendaten i

444 RRRE PP PEHF L ReWQ s Ogeeaa [l es PO W =
OR-B @ " dhRNa L=y = "EX - Sa@d 1@.: S@O [dieldd30] L
Layer &)%) | . . "
= Vektorhohenlinien erzeugen
-
| Aus dem interpolierten Hohenraster lassen sich Vektorh6henlinien als Linienshapefile extrahieren.
4| Das GIS errechnet aus dem Hohenraster Linien gleicher Hohe und speichert Sie als Shapefile mit
A der jeweiligen Hohe als Attributwert ab.
""" Hohenabstand und Intervall der Linien ist beliebig einstellbar.
Hohenlinien lassen sich gut zur dezenten Visualisierung von Hohen in thematischen und
topographischen Karten verwenden, da die Shapefiles einfach in Strichdicke und Farbe zu
» visualisieren sind.
® @ Vorgehensweise unter ArcGis
D) . o
9 ArcToolbox3D > Rasteroberflache > Konturlinie
SpatialAnalystTools > Surface > Contour List
B Greift aus das Programm gdal_contour
b aus den GDAL-Tools zuriick, die
) mit QGIS installiert werden.
.": -

<+C z Vorgehensweise unter QGIS

/

A4 Raster > Extraktion >Kontur (gdal_contour) oder
Erw. > GRASS > GRASS-Werk. >Raster >Raumliche Analysen > Oberflachenverwaltung> Vektorkonturlinien

. . UNIKASSEL Architekt
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SRTM-Daten visualisieren

24 RRE L LPPSE
© L) B s i B &

R O R e XIS
"EE - S @eée @

T=20%& [QlaC

R eciNoNe:
—

1 T T 1 T T
i i 1 i 1 I et
1 1 | | 1 - 114
L. L L4 L L. = L

Layer [

Vektorhohenlinien erzeugen

N
¥

ey

Hohenlinien mit Beschriftung
uberklassifzierten Hohenraster

ﬁ
—
N .@

Dialog Beispiel aus QGIS

-

Menuaufruf: Raster > Kontur (gdal_contour)

] Kontur E

L=
[~ Wizhlen...
[iatenanalyse_zommoehenﬂmntﬂ ]

Eingabedatei (Raster}: [ Interpolation

Ausgabeverzeichnis fiir Konturlinien {Shapedatei}:

Intervall zwischen Konturlinien: [ 10,00 lji‘
Attributname:

x [HoeHE ]
\Wenn nicht angegeben, wird kein Hehenattribut zugefiigt, =

[ Mach Abschluss zur Karte hinzufiigen

gdal_contour -a HOEHE 4 10.0 D: fLehre/GIS_2_Kompaktseminar /velktordatenanalyse_2010/hoehenfinterpol Lasc
D:fLehre/GIS_2_Kompaktseminar fvelktordatenanalyse 2010 hoehen fkontur

Interpoliertes Hohenraster
als Eingabedatei

Ausgabeverzeichnis fir das
Shapefile mit Namen Contour.shp

Hohenabstand der Hohenlinien
in Meter

Name der Attributspalte mit
den Hohenwerten

Resultierender
GDAL-Kommandozeilenbefehl

Online-Datenquellen mit QGIS
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